LLumar PrecisionCut 4
# Table of Contents

What's New................................................................................................................................ 1
What's New in This Version .................................................................................................... 1
Auto Nest ................................................................................................................................... 2
Customized Pattern Database .............................................................................................. 4
User Comments and Notes .................................................................................................... 6
Multiple Pattern Merge ........................................................................................................... 7
Side Bar with Tab Interface ................................................................................................... 9
Special Effects ...................................................................................................................... 10
Pattern Overlap Warning ....................................................................................................... 12
Customizable Toolbox ........................................................................................................... 13
New Custom High Color Toolbars ......................................................................................... 14
User Friendly Interface ........................................................................................................... 16
Pattern Fill Colors ................................................................................................................ 17
Rulers and Guideline Tools ................................................................................................... 20
Improvements ........................................................................................................................... 21
Easy Editor ................................................................................................................................ 21
Shapes commands .................................................................................................................. 23
Material Library ...................................................................................................................... 25
Plotter Connectivity/Functionality ........................................................................................... 26
New Pattern Updates .............................................................................................................. 28
Working with Tabs .................................................................................................................. 29
The Library Tab ....................................................................................................................... 29
The Layers Tab ........................................................................................................................ 32
The Cut Tab ............................................................................................................................. 34
The History Tab ........................................................................................................................ 39
Working with the Table ........................................................................................................... 41
Changing the height ............................................................................................................... 41
Moving and rotating patterns ................................................................................................. 42
Zooming on the table .............................................................................................................. 43
LLumar PrecisionCut 4

Editing ....................................................................................................................................... 45
Working with Patterns and Graphics...................................................................................... 45
Advanced ............................................................................................................................... 46
Recreating with Bezier Curves ............................................................................................ 47
Command Reference ............................................................................................................. 49

File Menu .................................................................................................................................. 49
New ....................................................................................................................................... 49
Open ...................................................................................................................................... 50
Open Recent .......................................................................................................................... 52
Close ...................................................................................................................................... 53
Save ...................................................................................................................................... 54
Save As ................................................................................................................................. 55
Save Copy As ........................................................................................................................ 56
Save Customized Pattern ...................................................................................................... 57
Import .................................................................................................................................... 58
Database UI ............................................................................................................................ 59
Update Pattern Database ....................................................................................................... 67
Update Patterns from Disc ..................................................................................................... 69
Submit Pattern Issue ............................................................................................................... 70
Print Table ............................................................................................................................. 71
Print Workspace ..................................................................................................................... 72
Edit Menu ............................................................................................................................... 73
Undo ..................................................................................................................................... 73
Redo ..................................................................................................................................... 74
Cut ........................................................................................................................................ 75
Copy ..................................................................................................................................... 76
Paste ...................................................................................................................................... 77
Paste Special .......................................................................................................................... 78
Delete .................................................................................................................................... 79
Duplicate ................................................................................................................................. 80
Select All ................................................................................................................................. 81
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste in Place</td>
<td>82</td>
</tr>
<tr>
<td>Easy Editor</td>
<td>83</td>
</tr>
<tr>
<td>Convert Bezier Curves</td>
<td>85</td>
</tr>
<tr>
<td>Convert Exploded Vector Paths</td>
<td>88</td>
</tr>
<tr>
<td>Vector/Node editing</td>
<td>89</td>
</tr>
<tr>
<td>Reorder Loops</td>
<td>90</td>
</tr>
<tr>
<td>Purge Undo/History</td>
<td>91</td>
</tr>
<tr>
<td>View Menu</td>
<td>92</td>
</tr>
<tr>
<td>Zoom commands</td>
<td>92</td>
</tr>
<tr>
<td>Toolbox Editor</td>
<td>94</td>
</tr>
<tr>
<td>Toolbars</td>
<td>96</td>
</tr>
<tr>
<td>Side Bar</td>
<td>98</td>
</tr>
<tr>
<td>Anti-Aliased</td>
<td>99</td>
</tr>
<tr>
<td>Refresh</td>
<td>100</td>
</tr>
<tr>
<td>Show Fill Colors</td>
<td>101</td>
</tr>
<tr>
<td>Show Grid</td>
<td>102</td>
</tr>
<tr>
<td>Show Guidelines</td>
<td>103</td>
</tr>
<tr>
<td>Show Rulers</td>
<td>104</td>
</tr>
<tr>
<td>Show Loop Direction</td>
<td>105</td>
</tr>
<tr>
<td>Show - Show Info Bar</td>
<td>106</td>
</tr>
<tr>
<td>Show - Show Help Bar</td>
<td>107</td>
</tr>
<tr>
<td>Highlight Small Vectors</td>
<td>108</td>
</tr>
<tr>
<td>Layout Menu</td>
<td>109</td>
</tr>
<tr>
<td>Guides commands</td>
<td>109</td>
</tr>
<tr>
<td>Shapes</td>
<td>111</td>
</tr>
<tr>
<td>Rotate commands</td>
<td>122</td>
</tr>
<tr>
<td>Layout Properties</td>
<td>124</td>
</tr>
<tr>
<td>Snap to Grid</td>
<td>126</td>
</tr>
<tr>
<td>Snap to Guidelines</td>
<td>127</td>
</tr>
<tr>
<td>Snap Dimensions to Graphics</td>
<td>128</td>
</tr>
<tr>
<td>Selectable Guidelines</td>
<td>129</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Connect</td>
<td>166</td>
</tr>
<tr>
<td>Effects</td>
<td>167</td>
</tr>
<tr>
<td>Outline</td>
<td>167</td>
</tr>
<tr>
<td>Shadow</td>
<td>169</td>
</tr>
<tr>
<td>Shadow</td>
<td>172</td>
</tr>
<tr>
<td>Shadow</td>
<td>175</td>
</tr>
<tr>
<td>Shadow</td>
<td>178</td>
</tr>
<tr>
<td>Weld</td>
<td>181</td>
</tr>
<tr>
<td>Warp</td>
<td>182</td>
</tr>
<tr>
<td>Sphere</td>
<td>184</td>
</tr>
<tr>
<td>Cylinder</td>
<td>185</td>
</tr>
<tr>
<td>Cut</td>
<td>186</td>
</tr>
<tr>
<td>Add to Table</td>
<td>186</td>
</tr>
<tr>
<td>Auto Nest</td>
<td>188</td>
</tr>
<tr>
<td>Prenested</td>
<td>190</td>
</tr>
<tr>
<td>Start/Stop/Abort/Delete</td>
<td>193</td>
</tr>
<tr>
<td>Weed Borders</td>
<td>194</td>
</tr>
<tr>
<td>Weed Borders</td>
<td>195</td>
</tr>
<tr>
<td>Setup</td>
<td>196</td>
</tr>
<tr>
<td>Poll Material Width</td>
<td>200</td>
</tr>
<tr>
<td>Tools</td>
<td>201</td>
</tr>
<tr>
<td>Options</td>
<td>202</td>
</tr>
<tr>
<td>Switches</td>
<td>217</td>
</tr>
<tr>
<td>Layout Tool</td>
<td>220</td>
</tr>
<tr>
<td>Vector Editing Tool</td>
<td>221</td>
</tr>
<tr>
<td>Loop Editing Tool</td>
<td>224</td>
</tr>
<tr>
<td>On-Screen Digitizing Tool</td>
<td>225</td>
</tr>
<tr>
<td>Dimensions</td>
<td>226</td>
</tr>
<tr>
<td>Measure</td>
<td>229</td>
</tr>
<tr>
<td>Radius Corners</td>
<td>231</td>
</tr>
<tr>
<td>Recreate with Bezier Curves - Tight</td>
<td>232</td>
</tr>
</tbody>
</table>
What's New

What's New in This Version

Welcome to LLumar Precision Cut 4!

In this version we have these exciting new and improved features:

- Auto Nest
- User Comments and Notes
- Customized Pattern Database
- Side Bar with Tab Interface
- Special Effects
- Pattern Overlap Warning
- Customizable Toolbox
- Rulers and Guideline Tools
- Easy Editor
- Shapes
- Material Library
- Plotter Connectivity/Functionality
- New Pattern Updates
Auto Nest

The new Auto Nest feature makes it easy to create efficiently nested patterns that will save you material and cost.

To use Auto Nest, first add the elements from the pattern that you want to nest onto the table (remember that you can create several tables per pattern). Then select Auto Nest from the Cut Menu or simply click on the Auto Nest button in the Cut Tab on the lower right of the screen.

The feature will take each of the objects on the table and efficiently position them, using rotation if beneficial, to achieve a tight nest.

There are two important user options that you can change as needed:

1. Nest Padding - this determines how close two objects can be on the table. The factory default is 0.25" and you can make this value larger or smaller. The Nest Padding value is in the Cut Tab for easy access.

2. Auto Nest Rotations - the factory default is 8, meaning that objects can have 8 rotation options: 0, 45, 90, 135, 180, 225, 270, and 315 degrees. If you make the value smaller, such as 4, then you will have four rotation options: 0, 90, 180, and 270 degrees. This will result in faster operation of the feature. If you make the value larger, such as 12, then you will have 12 rotation options and the feature will be a little slower. The actual impact on the final nest is determined by the objects to be nested. ** Please note that Window Film can only be rotated in plus or minus 45 degree increments.

If you add a Group to the table, you can choose to maintain the Group on the table, meaning that the individual pieces will not be nested. This may be preferable in cases where the original pattern has a nested pattern, and it isn't worth a modest increase in efficiency to have the
pattern elements distributed around the table. To maintain the position of the elements in a Group, select the Group on the table by drawing a box with the left mouse button and then use the Prenested command, either from the Cut Menu or with the shortcut key "P." Please see the topic on the Prenested command.

In this example on the right, the Lotus Elise, the front hood, fenders, and mirrors are fairly well nested in the original pattern. This Group has a height of 55”, so it is good for a 60” width material.

Additionally, after the Auto Nest routine is finished, you then have the option to further optimize the nesting through changes in the position and/or rotation of each object. Remember that when working with objects on the Cut Table, you can use the arrow keys on the keyboard to move objects, and you must hold down the CTRL key if you want to move and/or Rotate an object over another one. You may also use the Prenested command after the initial nesting.

Here is an example of a nested pattern: Volkswagen Touareg 2 V8, 2008-2010

At the bottom of the screen in the Status/Help Bar, you'll see the Width, Length, and Square Feet of the material used for the nesting, as well as the Efficiency, which is a calculation of the area that is being covered by pattern objects divided by total area. The higher the Efficiency, the more optimal the use of the material.
Customized Pattern Database

LLumar Precision Cut 4 now has the ability to save custom patterns to your local computer. This is particularly useful in three main cases:

You have made changes to the pattern, most likely with the Easy Editor, which enables you to select a range of vectors and move them all together to optimize a pattern. So if you find that you need to make an adjustment to a certain stock pattern, you will not have to make that adjustment each time you load that pattern.

1. You have created one or more nested Cut Tables using the Auto Nest feature, and by saving that pattern, you don't have to nest the objects again.
2. You have written User Comments and Notes on this pattern and want to save them for future use. Even if you have not made any pattern changes or created any nested tables, you can still save the pattern just with these comments/notes.

After making one or more of the above changes, you can save the customized pattern either in the File Menu: Save Customized Pattern, or in the Cut Tab: Save Custom.

You will then see this dialog box:

![Add Custom Pattern dialog box]

When you make a change to a pattern using the Easy Editor, and it may just be one small change to one object, the entire pattern will be saved to your local pattern database. This graphic shows 15 objects being added for this vehicle.

The next time you go to Open that pattern, you will be prompted with this question:
If you click Yes, it will load the pattern you saved, and if you say No, it will load the stock pattern from the main pattern database. You can also remove it from the custom pattern database with the Remove button.

Please note that with Multiple Merged Patterns in the layout, you must have one object or group selected when you click on the Save Custom button, so that the software knows where to save the custom pattern.
User Comments and Notes

In addition to being able to save customized patterns, you can also save your own comments and notes about each pattern for the next time you or someone else does that job.

To enter this information, just type in the space where it says Comments and then click on Save Custom. Please note that you can save a file to your local customized pattern database just with these Comments and/or you can save it with changes to the actual pattern data and/or nested cut tables.

The comments that you add here should be relevant for the next time this job/file is accessed. It may have something to do with the pattern itself or the installation. In larger shops/dealerships, the assumption may be that someone else will be the next one to access this file, so whatever you learn from doing this job should be put into the comments.
Multiple Pattern Merge

You can easily merge two or more patterns in one layout file with the Merge command in the Library Tab.

To use the Merge command, simply select the appropriate pattern and click on the Merge button. If instead you click on the Open button, then the selected pattern will open in a new layout.

The Merge command enables you to make nested patterns on the Cut Table with elements from multiple vehicles.

Here is an example of two merged patterns of the same vehicle, but different year ranges:
If you make changes to one of the patterns in a merged layout and want to save those changes to your custom database, be sure to have an element or group selected from the vehicle that you want to save before you click on Save Custom in the Library tab.
Side Bar with Tab Interface

As a way to provide easier access to commands and place more data at your fingertips, LLumar Precision Cut 4 has a dedicated Side Bar with several Tabs: Library, Layers, Cut, and History. The default is for the Side Bar to be visible, and this should always be the case unless you need more horizontal screen space. You can selectively show or hide individual tabs with the Side Bar command in the View Menu.

The Library Tab is where you can Open and Merge patterns, Save Custom patterns, and add Comments to your patterns.

The Layers Tab is used to control various aspects of your design using a tree format. You can rearrange layers, add layers, and remove layers, as well as hide or show individual graphics with a single click.

The Cut Tab is the main interface to your plotter/cutter. It also contains functions for Cut on Pull, Auto Nesting, and managing multiple Cut Tables.

The History Tab displays a constant stream of actions that you can use for Undo/Redo and in general to see what you’ve done in the software.

These tabs make it faster to work in the software, because you don’t have to click on icons or find these functions in a menu. In between the top tabs (Library and Layers) and the bottom tabs (Cut and History), there is a thin horizontal line that you can use to adjust the vertical spacing. Similarly, along the left edge of the Side Bar, you can drag it to be wider or skinnier, depending on your screen resolution and the information displayed in the tabs.
LLumar PrecisionCut 4

Special Effects

LLumar Precision Cut 4 contains a number of special effects that you can use on text, shapes, and graphics.

Please follow these links for more information on each special effect.

- Outline
- Shadow
- Extruded Shadow
- Cast Shadow
- Perspective Shadow
- Weld
- Warp
- Sphere
- Cylinder
- Text on a Path

Please note that objects from the Paint Protection and Window Film libraries are not intended for these Special Effects. In fact, the pattern elements are "locked" from inadvertent scaling and slanting.
Pattern Overlap Warning

When you are nesting patterns on the cut table or editing an Auto Nested pattern, it is very important that objects do not inadvertently overlap. The Pattern Overlap Warning will turn all overlapping patterns red so that they are impossible to miss. In this nesting of a paint protection pattern, the headlight is clearly overlapping the hood. The headlight is bolded, meaning that it was the selected object.

The Nest Padding value in the Cut Tab determines how close two objects can be on the table before they show up with red outlines. So if you have a value of .25” for Nest Padding, if two objects are closer than that, they will show up with red outlines even though they technically do not overlap.

If you have a nested patterns with an overlap like this, when you go to cut the pattern, you will be warned with the following message:
Customizable Toolbox

There's a new customizable toolbox. You can define your own icons, choose your preferred size of the icons, and more easily rearrange the icons in the toolbox with drag and drop. We provide a small set of toolboxes that you can choose from in the View, Toolbox menu. See Icon Editor for information on customizing the toolbox.

When using the Toolbox tab in Options, you can assign an icon a group name, and then when using the live toolbox, you have the option of collapsing or expanding all icons in that group, with either a right button click to bring up a menu, or Shift + Right button click to immediately collapse or expand the icon group without the menu.

Moving Icons with Drag and Drop
It's now very easy to customize the order of icons in the toolbox. If you want to move an icon from one place to another, you can simply left click and drag it to the location while holding down the ALT key.

Deleting Icons from the Live Toolbox
To delete icons from the toolbox, RIGHT CLICK on the icon while holding down ALT. A confirmation will appear. Press Yes to delete the icon or No to cancel.

Expand and Collapse Icon Groups
Icons can be assigned a group name in the Toolbox Options tab. Icons in these groups can then be expanded and collapsed together, leaving the top icon in the group as the single visible icon. The small triangle at the lower right of an icon with a group name can be used to expand or collapse the group.

Detaching Icon Groups
To turn an icon group into a floating or dockable toolbar, right click on the icon and select Detach. That icon group becomes a floating toolbar, which you can then dock to the sides of the screen or leaving floating.

Right Click Menu
You can right click on any icon to bring up the menu. If it's part of an Icon Group, will you see those icons listed by menu command name, along with the associated shortcut key. If the icon is not part of a group, you will see three options - Delete, Expand All and Collapse All.

Expand All
This option in the toolbox menu will expand all icon groups.

Collapse All
This option in the toolbox menu collapse all icon groups.
**New Custom High Color Toolbars**

You can assign a group name to individual icons, and all icons with the same group name automatically become a toolbar that you can dock to the edge of the screen or float in the workspace. To detach a flyout from the toolbox into a new toolbar, right click on the icon that has a flyout and select Detach from the menu. That flyout now becomes a floating toolbar. See Toolbox for information on defining the groups that make up the new custom toolbars. Here is the dialog box you use to define the custom toolbars:

![Toolbox dialog box](image)

In the above example, “Standard” on the right side of the list indicates that those icons are part of the Standard toolbar, the one that appears at the top of the workspace in the factory installation.

Here is an image of the Standard toolbar docked to the top of the screen, as defined in the above configuration:
You can Attach a toolbar into the left side toolbox by right-clicking on the toolbar and selecting Attach. The toolbar remains on the screen, but the toolbox now has a new icon group. The size of the toolbar icons is the same as the icon size configured in the High Color Toolbox Editor. If you change this size, the toolbox and toolbars are redrawn at the new size.
User Friendly Interface

LLumar Precision Cut 4 software has a brand new, user friendly interface that will increase your productivity.
Please also see Getting to Know the Desktop.
Pattern Fill Colors

Color can easily be added to any pattern, text object, imported graphic, etc. through the Color Palette.

To fill an object or group of objects with color, simply select it/them and click on the color you want from the color palette on the right of the screen.

If an object has any open loops, they will be closed prior to adding color.

Before you fill an object with color, it will have one of the following outline color schemes:

1. Blue and Red - this indicates closed loops. Blue loops are outside loops and red loops are inside loops.

2. Black - this indicates open loops, which will be automatically closed when you fill with color.

3. Green - this means that the object or group has been added to the table. This will help you to keep track of what has been added to the table from the main layout.
Once you add color to an object, these outlines will be replaced with the fill colors:

Note that with some Effects, such as Outline and Shadow, you can have two or more colors:

OUTLINE
SHADOW
Rulers and Guideline Tools

Rulers and Guidelines are important design and layout tools that should be turned on all the time.
Here are the icons in the Standard toolbar across the top of the screen:

You can also select Show Guidelines and Show Rulers in the View Menu.
This graphic shows both rulers and guidelines:

Rulers are displayed either in inches or millimeters, depending on which unit of measure you have selected in the Tools Menu: Options: General tab. They will be displayed along the top and left side of the main layout window, but not in the Cut Table (which as a user-adjustable Grid display). As you zoom in and zoom out, the rulers will adjust automatically to give you an appropriate level of measurement.
Guidelines are useful for lining up multiple items on an axis and ensuring the correct positioning of objects and groups. To add a Guideline, simply position the mouse over one of the Rulers, and click and drag into the layout window. Guidelines actually have their own property bar, where you can set the X or Y position, set the angle, lock and unlock, delete, and more. For more information, please see Using Guidelines and the Guideline Property Bar.
Improvements

Easy Editor

The *Easy Editor* provides a simple way to make subtle changes to the stock window film patterns to suit your installation preferences and/or better match the vehicle.

This tool works by making selections of multiple points (nodes) and allowing you to move the whole selection in three ways:

1. Click on the arrow to move the whole selection by preset distances (ie 1/16”).
2. Use the keyboard arrow keys to move the selection.
3. Manually drag the selection to a new position.

To use the Easy Editor, select a pattern object using the Layout Tool and then click on the icon from the toolbar. You can also get into the tool by selecting it from the Edit Menu or by clicking on this icon while in the Vector Edit mode.

When the Easy Editor first launches, it will zoom in on the selected object so that it fills the screen and show several double-sided arrows at different points around the perimeter. These indicate where you can adjust the pattern.

Now by simply clicking on the end of the arrow that you want to move, you can make subtle adjustments to the pattern.
To set the default nudge amount per click, go to the Tools Menu, Options dialog box, Tools tab and enter the value in Easy Editor Nudge Amount. Remember that these adjustments should be very minor, fractions of an inch.

One final note: even though there may be arrows all the way around some of these patterns, that does not mean that adjustments on all sides are appropriate. Be careful not to change the shape of the top of a roll up window, for example.

When you make edits to the pattern, the original path and the new path will both be shown. In this example, the original path is in purple and the new path is in black. This pattern was edited both on the left and along the bottom.

If you make an edit to a pattern and you want to save that edit for the next time you cut that pattern, then be sure to save it to the custom pattern database.
Shapes commands

The Shapes menu lists the available geometric shapes available. When you pick one, the cursor changes to indicate which kind of shape you will create. Simply press and hold down the left mouse button, while dragging the mouse so that the desired shape is created.

You can then manipulate this shape just like text or logos. However, there is one minor difference: You cannot simply click anywhere in the boundary of the shape, to select you must click one of the lines or arcs to select this shape for further manipulation.

The available Shape tools are as follows:

The first four are simple and create the expected shape:

Rectangle

Square

Circle

Ellipse

Rounded Rectangle

Polygon

Arrow

Note: Use Alt when dragging a rectangle to force modal mode and keep the tool active after creating a rectangle, if the modal tool option is not enabled in Options, Tools.
Material Library

Our entire library of films and materials is now included in the software. You can see this list in the Database Utility, Film Inventory tab:

<table>
<thead>
<tr>
<th>Film:</th>
<th>LLUMAR : ARCH - SAFETY : SCL SR PS8</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID:</td>
<td>LLUMAR : ARCH - SAFETY : SA15CHSRPS4</td>
</tr>
<tr>
<td>Brand:</td>
<td>LLUMAR : ARCH - SAFETY : SCL SR PS11</td>
</tr>
<tr>
<td>Category:</td>
<td>LLUMAR : ARCH - SAFETY : SCL SR PS15</td>
</tr>
<tr>
<td>Film Name:</td>
<td>LLUMAR : ARCH - SAFETY : SCL SR PS4</td>
</tr>
<tr>
<td>Original Roll Length:</td>
<td>LLUMAR : ARCH - SAFETY : SCL SR PS6</td>
</tr>
<tr>
<td></td>
<td>LLUMAR : ARCH - SAFETY : SCL SR PS7</td>
</tr>
<tr>
<td></td>
<td>LLUMAR : AUTO - PPF : Urethane PPF 6Mil</td>
</tr>
<tr>
<td></td>
<td>LLUMAR : AUTO - PPF : Urethane PPF 8Mil</td>
</tr>
<tr>
<td></td>
<td>LLUMAR : AUTO - SAFETY : SA15CSRPS8</td>
</tr>
<tr>
<td></td>
<td>LLUMAR : AUTO - SAFETY : SA35CSRPS8</td>
</tr>
<tr>
<td></td>
<td>LLUMAR : AUTO - SAFETY : SA50CSRPS8</td>
</tr>
<tr>
<td></td>
<td>LLUMAR : AUTO - SAFETY : SCLSRPS7</td>
</tr>
<tr>
<td></td>
<td>LLUMAR : AUTO - SOLAR : AIR80 BL SR HPR</td>
</tr>
<tr>
<td></td>
<td>LLUMAR : AUTO - SOLAR : AT35 GN SR HPR</td>
</tr>
<tr>
<td></td>
<td>LLUMAR : AUTO - SOLAR : ATC05 CH SR HPR</td>
</tr>
<tr>
<td></td>
<td>LLUMAR : AUTO - SOLAR : ATC15 CH SR HPR</td>
</tr>
<tr>
<td></td>
<td>LLUMAR : AUTO - SOLAR : ATC20 CH SR HPR</td>
</tr>
<tr>
<td></td>
<td>LLUMAR : AUTO - SOLAR : ATC35 CH SR HPR</td>
</tr>
<tr>
<td></td>
<td>LLUMAR : AUTO - SOLAR : ATC40 CH SR HPR</td>
</tr>
<tr>
<td></td>
<td>LLUMAR : AUTO - SOLAR : ATC50 CH SR HPR</td>
</tr>
<tr>
<td></td>
<td>LLUMAR : AUTO - SOLAR : ATC70 CH SR HPR</td>
</tr>
<tr>
<td></td>
<td>LLUMAR : AUTO - SOLAR : ATR05 CH SR HPR</td>
</tr>
</tbody>
</table>
LLumar Precision Cut 4 has a number of improvements and new capabilities is working with your plotters/cutters:

- Larger set of drivers for common industry vinyl cutters
- Open driver format that enables you to make changes if necessary
- Additional support for USB connections to vinyl cutters
- New Cut Tab interface:

From the Cut Tab, you have many options conveniently available at all times:

- Select your vinyl cutter
- Select the method of connecting to your cutter
- Go into the cutter driver through the Setup button
- Plot the current job
- Pause or Abort the current job
- Select the Cut on Pull option
- Display the Grid on the cut table and change the grid scale
- Select the Material Width
- Choose to add a Weed Border (WB)
- Select the Table you wish to view or Add a new table
- Set the Nest Padding for objects on the table
- Auto Nest the objects on the current table
• Poll the Material Width from the cutter

Please see the section [Working with Tabs: Cut Tab](#) for more information on these options.
**New Pattern Updates**

The procedure for updating your copy of the software with new paint protection and window tint patterns has been completely automated. Now when you launch the software, it will bring up the following dialog box and check the master pattern database for pattern updates/additions since your last update. It will list the patterns it finds with the complete filenames as shown. You have the option of getting these updates by clicking on Update From Web or Canceling without updating. You can also Refresh the list. If there are no patterns to update when you start the software, this dialog box will go away on its own.

![Update Patterns Dialog Box](image)

This new approach to updating and adding new patterns will keep you up to date at all times. Remember that any custom patterns that you have saved to your local database will not be impacted by these updates. Patterns that have been replaced by newer versions will be removed from the pattern database automatically, with custom saved patterns remaining intact.
Working with Tabs

The Library Tab

The **Library Tab**, on the right side of the screen at the top, is where you Open and Merge patterns, Save Custom patterns that you've edited, and save Comments that you've written about a pattern.

This tab is laid out to work from the top down, so as you select an item from each list, the remaining lists will be updated with the available options. For example, in this graphic, the first item selected is "PAINT PROTECTION." The other options are "WINDOW TINT" and "GRAPHICS." Then you select the Make or Brand of vehicle, in this case "Buick." Next is the Model, "Enclave." Finally, the year or range of years for that particular vehicle.

When all of the options are selected, you can either Open this pattern into a new layout, or Merge it with a pattern that is already open in the current layout. You would want to Merge a pattern with another in order to Nest objects from both patterns on one Cut Table to save material/production time.

If you make changes to the standard pattern for a certain vehicle, perhaps using the **Easy Editor**, you can then save that pattern back to your "Local Pattern Database" so that you don't have to make those same changes again the next time you need to access that pattern. To use this feature, simply make the changes and then click on Save Custom in the Library Tab. This prompt will come up confirming the pattern that you saved.
The next time that you open this pattern, you will be prompted either to open the standard pattern from the database, or the custom pattern from your local database.

The final item in the Library tab is the Comments field, which lets you write and save comments about a certain pattern. These comments can be anything you want, from notes about the vehicle, changes you made to the standard pattern, installation instructions, how this pattern might relate to previous years, etc. Comments are saved using the Save Custom button. Note that you do not have to make any changes to the actual pattern to save the Comments using Save Custom. A pattern can be changed and/or notes can be added when you use the Save Custom command.

If you have two or more Merged files in the layout and you want to save one of them back to the Custom Patterns database, simply select one of the objects in that pattern before clicking on the Save Custom button. If you have a Merged pattern and want to save one of them to the database, but do not have anything selected in the layout, you will be prompted to select one of the patterns first.

NOTE: It is important here to note the distinction between Saving and Opening *.lpc files as opposed to Opening/Merging Paint Protection/Window Tint patterns and saving Custom Patterns to your local database.

The normal workflow should be to open a pattern from the Paint Protection or Window Tint database here in the Library Tab, as described above. This database is updated as frequently as you want "from the factory," and you can also open your saved Custom Patterns. If you are working with patterns in this way for vehicles in the database, there is no need to Save an *.lpc file on your local file system.

Saving *.lpc files should be used in cases where you have created a layout that is not directly attached to a standard Paint Protection or Window Tint pattern, such as text and effects, shapes, or imported graphics files. It is also a good idea to save a Merged pattern.
The Layers Tab

The **Layers Tab** is used to control various aspects of your design using a tree format. You can rearrange layers, add layers, and remove layers, as well as hide or show individual graphics with a single click.

Here is the Layers Tab showing a 2009 Nissan Maxima 4 Door Sedan Window Tint pattern. The back glass pattern is selected in the layout and therefore highlighted in the tab. You can select objects in the layout by first selecting them in the tab, or you can select an object in the layout and it will be highlighted here in the tab.

**Add Layer**

Use this to create a new layer.

**Move to Layer**

This button makes it easy to move a graphic to another layer or a new layer by name.

**Delete Layer**

This will remove the selected layer.

**Print Layer**

Check this button to print the selected layer.

**Cut Layer**

Check this button to make sure this layer is sent to Plot Manager.
Enable Editing of All Layers ✓
Check this edit all layers, even those normally locked.

Collapse All But Selection ▶
Check this button to make it easier to manage complex jobs with many elements. When button is pressed, only the layer the selected object is part of will be expanded.

Editable ▷
This indicates whether the selected layer can be changed.

Show/Hide Object ☰
Press the eye icon to show or hide an element in the layers tab, which can be a layer, a group, a graphic or a property.

Group Indicator ★
This indicator shows you which graphics part of any selected group.

<Group>
This lets you expand or collapse an entire group. If a group spans multiple layers, this will NOT be displayed.

Open Properties
Press the gray arrow to open or close the properties for a graphic.

Selecting Objects with the Layers Tab
When an object is marked not Editable or Locked, you can still select it with the layers tab, and then select the Editable or Locked commands to re-enable editing with the mouse.
The Cut Tab

The Cut Tab contains many functions for cutting and working on the cut table. This tab is toggled with the History Tab.

Below are descriptions of all available functions.

Select your vinyl cutter

This is a drop down list, so when you click on it, a large list of vinyl cutters will appear. Select yours from the list.
Select the method of connecting to your cutter

There are four primary ways to connect to your cutter: COM ports, LPT ports, USB port, and Windows Printer Driver.
LLumar PrecisionCut 4

Most modern vinyl cutters use USB to connect from your computer to the cutter, but COM ports can still be used. Be sure to select the correct USB or COM port as computers often have several of each.

The Windows Printer Driver is essentially installing your vinyl cutter as a Windows printer device. The benefit to this method is that Windows handles setting up and communicating with your cutter.

- Go into the cutter driver through the Setup button

LLumar Precision Cut 4 provides users with the capability to customize the cutter drivers. Please see Cut Menu: Setup command for more details. Do not change the cutter driver unless you know what you're doing!

- Plot the current job

This will send the current pattern on the table to the cutter. Make sure the cutter is loaded with material and ready. If necessary, do Poll Material Width prior to cutting.

- Pause or Abort the current job

These buttons will Pause or Abort the cut job. Please note that the cutter may not immediately stop if data has been sent and is in the cutter's buffer.

- Select the Cut on Pull option

Cut on Pull is a cutting technique that minimizes stress on the material by only cutting when the material is being "pulled" through the cutter, away from you. This is required for all window tint films. Thicker films, including paint protection and safety films, do not have the Cut on Pull requirement.

- Display the Grid on the cut table and change the grid scale

The cut table has an optional Grid so that you know the scale of the objects. The scale of the Grid is set in the accompanying box, 12" in the above graphic. It is a good idea to keep the grid visible as a reminder of the scale of your objects and the material width that you have set. The main layout window can be at different zoom ratios, so there is likely no correlation between the size of the objects in the layout window and on the table.
• Select the Material Width

LLumar Precision Cut 4 comes with standard material widths pre-programmed, and you can further add/delete/edit these values. The first value shown is the actual width of the material and the second value (in parentheses) is the usable width. If you click on the Edit button, you will get the following dialog box:

Here you can add New Media Widths, change an existing Media Width, Delete a Media Width, change the order of the Media Widths, and make one the default.

Please note: if you use the Poll Material Width command (see below), the usable width value can be updated from the data that is sent back from the cutter. The value obtained from the cutter is the critical value.

• Choose to add a Weed Border

A weed border is simply a box that is drawn around the entire pattern that is sent to the cutter. This can help in weeding the cut job. But care must be taken with weed borders and long tables, because cutting a weed border requires the cutter to feed the entire length of the material for the job through the cutter in each direction. If there are any problems with the registration of the material, this can be exacerbated with long, fast movements of the material.

• Select the Table you wish to view or Add a new table

The name of the current table is displayed in the window. You can scroll through the tables with the left and right arrows. To add a table, click on the "+" button.
For more descriptive table names, type in something other than "Table 1" or "Table 2." Here in this graphic, the fourth table is called "Custom name." Just type over the existing name and press Enter. Naming the table with the appropriate material name or part number would be a good idea, especially if you save the file to the Custom Pattern Database so that you can cut it again. Alternatively, each table can have its own material height if it is the same material.

- Set the Nest Padding and Auto Nest the objects on the current table

The Nest Padding value determines how close two pattern elements can be nested on the table. One inch is a safe value, and it should probably not be less than 1/4".

The Auto Nest button invokes the Auto Nest command with the objects on the table. Please see Auto Nest for more information.

- Poll the Material Width from the cutter

Even though the software has preset material widths and usable material widths, it is still recommended that you use the Poll Material Width command to ensure that the material loaded on your cutter has the available cutting width that you expect. The value returned from the cutter will be displayed in this window. This value is typically read from the inside of one pinch wheel to the inside of the other pinch wheel.
The History Tab

The **History Tab**, docked at the right of the workspace, lists all the actions, by name, that have been performed so far, and which may be undone or redone. Undoable actions are shown in a normal color, while redoable actions are shown in gray. To undo back to a specific point in the list, simply click that point in the list and the program undoes every action back to that point.

In this example, the last several actions, adding "TEXT" to the layout and then adding it to the table, have been Undone. They can be Redone by clicking on the bottom action, Add to Table. If you perform different operations after an Undo, then you cannot Redo those actions, as the chain of actions is broken.
Working with the Table

Changing the height

To change the height of the table on the screen, put the cursor at the top of the table. When the cursor changes from the arrow to the horizontal adjustment cursor, you can click and drag, and when the button is released, the table will be resized.

This does not change the material width of the table. To do that, use the Cut tab.
Moving and rotating patterns

To move and rotate patterns in the table, it works the same as in the workspace. Just click and drag, and to rotate, use the right mouse button.

When two patterns overlap, they will be both turn red to indicate the overlap. Press Del to remove a pattern.
Zooming on the table

To **zoom in** on the table, press Shift while making a box with the right mouse button. To **zoom out**, press Shift while pressing and releasing the right mouse button, without moving it.
Editing

Working with Patterns and Graphics

Types of Editing

- To arrange, rotate and delete complete patterns, use the **Layout tool**.
- To edit the vector paths of patterns, use the **Vector Edit Tool** or **Easy Editor**.
- To smooth the vector paths, you can use one of the tools for creating smooth Bezier paths.
Advanced

To manually modify the path of a pattern or imported graphic, you have a few options:

**Vector Edit Tool**
This tool gives you full control over the path, allowing you to insert, move and delete nodes at will.

**Loop Edit Tool**
This tool works on entire loops, which can speed up certain types of editing. You can move and delete loops easily.

**Alt Smoothing - arcs only**
This is part of the Vector Edit tool and makes it easy to convert a range of small nodes into smooth arcs and lines. Note that this does not create bezier curves.

To use this tool:
1. Start the Vector Edit mode.
2. Click on the start of the range of nodes you want to smooth.
3. Find the end of the range of nodes to smooth and left-click while holding down Alt.
4. The nodes will be convert to an arc.
5. If this causes too much deviation from the path, Undo and select a smaller range and try again.
Recreating with Bezier Curves

When you have some vector graphics that are not smooth, you can clean them with various tools. The recommended way is to create smooth bezier curves from the existing paths.

We have four ways to do that:

1. **Recreate with Bezier Curves - Tight**
2. **Recreate with Bezier Curves - Medium**
3. **Recreate with Bezier Curves - Loose**
4. **Convert Bezier Curves** - this gives you the most control over the process.

Please note that using the above commands on vehicle patterns is risky in that you can easily modify the pattern too much and it won't fit the vehicle. But if you know where the pattern needs to be modified and how much deviation is permissible, you can **Convert Bezier Curves** to good effect.
The New command allows you to start a new design, clearing the current one from the program. The Layout Property Bar appears when you select this command.
Open

The Open dialog allows you to load an existing file for further modification, printing or plotting. The various fields are described below:

Look in

Select the drive or directory you would like to open the file from.

File Name

Enter the name of the file you want to load, if you know the name, or choose one from the list of files below.

Files Of Type

Use this drop down list box to choose which file type you would like to have listed for you to choose from.

Use Snapshots (only when opening layouts)

Check this to use the snapshot feature when saving and opening layouts.

Thumbnail View as Default

Check this if you want the Open dialog to always open in thumbnail view.

Date

Date of last modified of the layout.

Size

Size of the file in bytes.

Layouts

Use this to instantly switch to the defined Layouts path.

Backups

Use this to instantly switch to the Backups Folder.

Note: Merge is now replaced by Import, and Delete is integrated with the dialog box. That is, you can simply press the Del key to delete a file.
Open Recent

This menu opens the list of recently opened files. Simply select the file you want to load and it opens.
Close

This command will close the current pattern only. It will not close the software. Use Exit to close the software.
Save

The Save command will allow you to save the current layout to disk. If the layout you are working on already has been saved, selecting the Save command will automatically overwrite the existing layout. If you have not previously saved the layout, the Save As dialog box will be displayed and allow you to enter the filename. The file will be saved as an LPC format.
Save As

The **Save As** dialog allows you to save your file under a new name.

**Save in**

Select the drive or directory you would like to save the file to.

**File Name**

Enter the name of your file here. You can type in a new directory—if you know it's name—and then press Enter to switch to it, and see the files in it.

**Save as Type**

Use this drop down list box to choose the file type you wish to save your file as.
Save Copy As

Use this variation on the Save As command to save a copy of your layout to a different file, without changing the name as it’s known by the program. The Save As command also renames the current layout when you invoke that command, but Save Copy As does not.
**Save Customized Pattern**

Use this command to save the current file as a customized pattern. When a customized version of a pattern exists in the Custom Pattern Database, when you open that pattern from the Library tab, you will be asked if you want to load the customized pattern instead.
Import

The **Import** command enables you to bring in vector files from another graphics/design program using industry standard file formats.

The file formats supported in LLumar Precision Cut 4 are:
- Interpreted Postscript / PDF (*.ai, *.eps, *.pdf)
- Encapsulated Postscript (EPS) (*.eps)
- AutoCAD DXF (*.dxf)
- AAMA (*.aam)
- HPGL (*.plt)
Database UI

The Database UI command brings up a dialog box which lets you configure the logging and tracking features of LLumar Precision Cut 4.

Click the links below for more information on each tab.

- Users tab
- Film Inventory tab
- Cut Log tab
- Rates tab
- Reporting tab
Users

This tab lets you manage the users of the system. Enter the name, password and other personal information. The labor rate is used in the reporting system.
**Film Inventory**

This tab lets you manage the film inventory.

**Film**

This is the list of films currently available.

**Brand**

This is the brand of the film selected.

**Category**

This is the film's category.

**Film Name**

This is the name of the film.

**Film Width**

This is the width of the film roll.

**Original Roll Length**

This is the total length of the original roll of film. This is used later in the reporting.

**Lot Number**

Enter the lot number of the roll of film.

**Inventory Units**

Enter how many rolls of this film you currently have in stock.

**Roll Cost**

Enter the total cost of this roll of film.

**Safety Stock**

Enter the safety stock number for this type of film in the inventory.
Cut Log

The Cut Log is a detailed log of cutting activity and is used in the reporting system.

User ID

This is the user ID of the user who did the cutting.

Make / Model / Year

This identifies the vehicle pattern used in the cut.

Pieces

This is the total number of individual patterns cut.

Width

Total width of the material used in this cut

Length

Total length of the material used in this cut

Efficiency

This is the calculated efficiency of the cut job, which relates the total area of the material used to the total area of the actual patterns cut.

Pattern Names

This box lists the names of all the patterns cut in this cut job.

Film Name

This is the name of the film used in the cut.

Film Material Cost

This is the calculated film cost of this cut.

Reason For Cut

This is the reason for cutting, which is optional.

Flag Rate

This is the flag rate for this cut, which is used in the reporting.
User Labor Rate

This is the labor rate for the user who made this cut.

Order Number

This is the order number for this cut (if specified).

Square Units

This is the calculated square footage of material used in this cut.

Total Cut Time

This is the total time needed to make this cut.

VIN Number

This is the VIN number entered for this job.
**Rates**

The **Rates** tab lets you enter the various rates used for different types of jobs.

**Car Type**

Select the type of car from this list.

**Film Type**

Select the type of film from this list.

**Flag Rate**

Select the flag rate from this list. The rates are entered in the Rates tab.

**Optional Rate 1**

Select the optional rate 1 from this list. This can be left blank.

**Optional Rate 2**

Select the optional rate 2 from this list. This can be left blank.

**Revenue**
Reporting

The **Report** tab lets you generate various reports based on data logged during cutting.

**Cut Log**

The Cut Log tab contains options for creating reports from the cut log. It displays a preview of a PDF file on screen, and you can save the report to a file.

**Make / Model / Year**

Select this to create a report showing the make, patterns cut, square units of material used, and the number of pieces cut.

**All Logs**

Select this to create a report showing the time, user, make/model/year, film, patterns, width, height, efficiency, order number, VIN number and reason for cut.

**Film Usage**

Select this to create a report showing date, make, model, year, VIN #, length of material, square units of material, film cost and percent of material wasted (outside of the pattern).

**By User**

Select this to create a report showing the date, user and number of cuts.

**Begin Date**

Use this to select starting date for the report.

**End Date**

Use this to select an ending date for the report.

**PDF Preview**

Press this to display a preview of the PDF report. Use the scroll bars and arrow buttons at the bottom to view the entire file.

**Film Info**

The Film Info area lets you create reports on film usage.
Inventory by Brand

Select this to create a report showing the current film inventory by brand.

User Report

Select this to create a report showing which users used which material.

All Inventory

Select this to create a report showing all current inventory, including brand, name, lot number and available inventory.

Depleting Inventory

Select this to create a report showing inventory that is running low.

Safety Stock Report

Select this to create a report showing the safety stock.

PDF Preview

Press this to display a preview of the PDF report. Use the scroll bars and arrow buttons at the bottom to view the entire file.
Update Pattern Database

The Update Pattern Database command connects to our pattern update server and downloads the new and updated patterns to your computer. If you update frequently, this process only takes a minute or two.

Check the box Check for Pattern Updates on Launch to have this load automatically when starting.
Update Patterns from Disc

If you do not have internet access, then you can update your pattern database from a disc instead of from a download. When you select this option, a dialog box will come up asking you to select the drive or folder that contains the update.
Submit Pattern Issue

If you come across an issue with a pattern from our database, please take a couple minutes to let us know about it.
Print Table

This command will print the current table contents to the printer of your choice. The maximum size is 11 x 11 inches.
Print Workspace

This command will print the current workspace contents to the printer of your choice. The maximum size is 11 x 11 inches.
Edit Menu

Undo

Use this command to reverse the last command you used. This can be done repeatedly until the point at which you created this layout, or last saved it. When you save a layout, the undo information is cleared. See Redo command.
Redo

The Redo command will let you repeat actions that were just undone. In order to use Redo, you must therefore have also used Undo.
If you use Undo and then Redo, then it works like a "toggle," where you can go back and forth between two or more actions.
If you have performed several actions without using Undo, then there is nothing to Redo and the function will not be available.
Note: When you undo some actions and then perform some new actions instead of redoing them again, the actions that were previously available for redo are cleared.
**Cut**

Selecting Cut will delete the selected object(s) (text, logo, loop, vector, etc.) from the layout and places it into the Clipboard, erasing the previous Clipboard contents. Use **Paste** to place the cut image in the same layout, another layout, or another application. You can also select this command by double clicking and holding down the mouse button, as you hold down the button move the cursor to the word Cut and release the button.
Copy

Selecting Copy will copy the selected object(s) (text, logo, loop, vector, etc.) from the layout and places it into the internal clipboard, leaving the original intact and erasing the previous clipboard contents.

**Note:** This will not use the Windows clipboard.

Use Paste to place the copied image in the same layout, another layout, or another application. You can also select this command by double clicking and holding down the mouse button, as you hold down the button move the cursor to the word Copy and release the button.
Paste

Selecting the Paste command will allow you to copy the contents of the Clipboard into LLumar Precision Cut 4. You can paste something that was Cut or Copied from LLumar Precision Cut 4 or other applications like Corel Draw. 

**Note:** You cannot Copy out of LLumar Precision Cut 4 into other software.
Paste Special

Select this command to paste something else besides the default data type. For example, if there is a metafile and a bitmap in the clipboard, and the normal Paste command only pastes the metafile, but you really want the bitmap, select Paste Special and choose the bitmap instead.
Delete

The Delete command is the same as Cut, in that the object or group of objects that is selected will be removed, but the selected objects will not be placed in the Clipboard. You can replace the deleted objects by selecting Undo. You can also select this command by double clicking and holding down the mouse button, as you hold down the button move the cursor to the word Delete and release the button.
Duplicate

This command will allow you to duplicate the select object(s). The new object(s) will be offset by 1/3 of the width in the X-axis and 1/3 of the height for the Y-axis.
Select All

The Select All command selects every object in the layout. This does not include guidelines.
**Paste in Place**

This command will paste an object into the current layout so that the size and position remains the same as the original object. This will not be available when other data types are used, such as EMF or a bitmap.
Easy Editor

The **Easy Editor** provides a simple way to make subtle changes to the stock window film patterns to suit your installation preferences and/or better match the vehicle.

This tool works by making selections of multiple points (nodes) and allowing you to move the whole selection in three ways:

1. Click on the arrow to move the whole selection by preset distances (ie 1/16”).
2. Use the keyboard arrow keys to move the selection.
3. Manually drag the selection to a new position.

To use the Easy Editor, select a pattern object using the Layout Tool and then click on the icon from the toolbar. You can also get into the tool by selecting it from the Edit Menu or by clicking on this icon while in the Vector Edit mode.

When the Easy Editor first launches, it will zoom in on the selected object so that it fills the screen and show several double-sided arrows at different points around the perimeter. These indicate where you can adjust the pattern.

Now by simply clicking on the end of the arrow that you want to move, you can make subtle adjustments to the pattern.

To set the default nudge amount per click, go to the Tools Menu, Options dialog box, Tools tab and enter the value in Easy Editor Nudge Amount. Remember that these adjustments should be very minor, fractions of an inch.
One final note: even though there may be arrows all the way around some of these patterns, that does not mean that adjustments on all sides are appropriate. Be careful not to change the shape of the top of a roll up window, for example.

When you make edits to the pattern, the original path and the new path will both be shown. In this example, the original path is in purple and the new path is in black. This pattern was edited both on the left and along the bottom.

If you make an edit to a pattern and you want to save that edit for the next time you cut that pattern, then be sure to save it to the custom pattern database.
Convert Bezier Curves

This tool will convert arcs and lines into smooth bezier curves, using a user-adjustable tolerance.

If you have a graphic that looked like this:

![Original Graphic]

this tool can make it look like this with just a click:
Tolerance

This value is the maximum distance from the original path that the smoothing operation is allowed is deviate.

Auto Preview

Check to see an immediate preview of the smoothing operation, with small black boxes indicating where the new bezier nodes are. All non-corner nodes will be tangent.

Preview

Press to manually preview the smoothing using the current Tolerance.

Done
Press this to accept the last smoothing result and exit the tool.
Convert Exploded Vector Paths

This will convert vector data that is composed of separate arcs and lines into a "polyline", or a connected series of lines and arcs, that form a closed polygon, which is necessary for cutting.
Vector/Node editing

To edit the component vectors of an object, select the icon shown from the toolbox.

Selecting Vectors to Edit

When you have correctly selected a vector, it will be displayed in dotted red. If you are having trouble selecting a vector, you may wish to increase the Proximity setting, listed in the Options dialog.

Once you have selected the Vector Editing icon, you can select an object you wish to edit. Once selected, the construction points that were used to create that object will be displayed. Once a vector has been selected you have the following functions available to you:

- Moving a Vector (with the mouse)
- Insert
- To Line
- To Arc
- To Bezier
- Break Loop
- Set Start/End
- Join Start/End
- Delete
- Add Horizontal Guideline
- Add Vertical Guideline

Also see Vector Editing Property Bar.
Reorder Loops

This command will reorder all the loops in the selected object so that they are properly ordered for outputting to cutting machines. This sequence is as follows:

1. Outer-most loops run clockwise, then each subsequent nested inner loop alternates between counter-clockwise and clockwise.
2. The innermost loops are drawn and cut before any outer loops.
Purge Undo/History

This command can be helpful when you are running low on memory and need to reclaim memory used by Undo/Redo.
View Menu

Zoom commands

Zooming in and out is done in the layout screen when you want to work on a specific section closer up or in more detail.

Zoom In

- Use the mouse wheel to zoom in. Roll the wheel away from your body until you have zoomed in to the appropriate level.
- You can also use the Zoom In icon. When you click on the icon, you are put in the zoom mode, and then you can draw a box around whatever you want to zoom in on. If you then want to zoom in some more, you have to click on the icon again and then draw a new box.
- If you have zoomed in to the wrong location, you can Pan across the screen by holding down the Spacebar and moving the mouse.

Zoom Out

- Use the mouse wheel to zoom out. Roll the wheel towards your body until you have zoomed out to the appropriate level.
- You can also use the Zoom Out icon, which will zoom out incrementally each time you click on the icon.

Zoom All

- Selecting the Zoom All command from the View menu will tell the program to redraw the screen so that everything placed in the layout will be displayed on screen for you to see.

Zoom Object

- If an object is selected, select this command to zoom in on this object only.

Zoom Layout

- Select this to zoom to the entire layout.

Pan
Hold down the Spacebar and move the mouse to enable panning of the zoom area in any direction.
Toolbox Editor

This command brings up the Toolbox Editor dialog box, which allows you to customize your toolbox and icons, including the icon size and grayscale options. You can select from any number of predefined configurations, drag icons to the toolbox to add them, and even recreate the toolbox using a different size for the icons.

Configuration

This list represents all of the toolbox configurations available. The Icons folder contains two files for every configuration: A .hci file containing the icons rendered as transparent bitmaps, and a .tbx file, containing the set of menu commands for the toolbox.

Icon Source

This lets you create a totally different icon set to use, which determines the actual look of each icon. To create an alternate icon source file, save the loaded layout to a different name in the special Icons folder (which is in the LPC4 program folder), then restart the software.

New

Press this button to create a new named toolbox configuration.

Remove

Press this button to remove the selected toolbox configuration.

Rename

Use this to rename the current icon configuration. This renames all associated files located in the Icons folder.

Menu Commands

This list is the all menu commands in the software that can be assigned an icon and/or placed in the toolbox. Not every command has an icon, but you can easily create one yourself.

The procedure for creating your own icons is simple:

1. Make sure the High Color Toolbox Editor dialog box is visible.
2. Create a new graphic or group, as if you were designing a sign, and select it.
3. Simply double-click the corresponding menu command in the Menu Commands list. This establishes a link between the graphic (as icon) and the menu command.
4. Click Render All Icons and your icon will be available as an icon shortcut for the menu command you choose. You can then drag that menu command / icon pair right onto the live toolbox to add it to the toolbox.

Icon Size
This is the size of the icons in pixels. The Margin setting will decrease the actual rendered size by the corresponding percent of this icon size.

**Margin**

This adds a margin around each icon so they don't bunch up too much and are easier to read.

**Grayscale**

This option will make all icons grayscale, if you prefer to not have our colorful icons interfere with the color perception of your designs.

**Highlight Unassigned**

This draws a small "U" next to all graphics that don't have a menu command associated with them.

**Default Toolbars**

This text box lets you define the default toolbars that appear docked at the top of the window when this icon configuration is selected. You enter here the names of the icon groups that identify the toolbars you wish see docked at the top of the window, separated by semicolons. The names must be exactly match the group names for them to appear.

**Render All Icons**

This command converts all the icons defining in the current layout to a set of small transparent bitmaps which are directly used in the high color toolbox.
Toolbars

LLumar Precision Cut 4 includes a flexible toolbar interface that allows them be moved, resized and “docked” as you like.

To move a toolbar, either from a docked position or floating position, simply grab it anywhere in the toolbar that doesn’t contain a button, and you can then move it to another position, just like dragging a graphic.

In the screenshot below, in addition to the basic toolbox docked on the left side, there are three docked toolbars at the top, and one floating toolbar (Rotate).

The standard toolbars as follows:

<table>
<thead>
<tr>
<th>Standard</th>
<th>File operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td>Selection, text editing, shapes</td>
</tr>
<tr>
<td>View</td>
<td>Related to viewing the layout</td>
</tr>
<tr>
<td>Zoom</td>
<td>Zooming</td>
</tr>
<tr>
<td>Layout</td>
<td>Laying out the sign</td>
</tr>
<tr>
<td>Arrange</td>
<td>Arrange elements</td>
</tr>
<tr>
<td>Text</td>
<td>Text editing</td>
</tr>
<tr>
<td>Category</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Effects</td>
<td>Special effects such as outline, weld, shadow</td>
</tr>
<tr>
<td>Vector Editing</td>
<td>Vector or node editing</td>
</tr>
<tr>
<td>Loop Editing</td>
<td>Loop or path editing</td>
</tr>
<tr>
<td>Property Bars</td>
<td>Object property bars</td>
</tr>
<tr>
<td>Custom</td>
<td>Custom user toolbars</td>
</tr>
</tbody>
</table>
Side Bar

Use this menu to show or hide the entire Side Bar, or to switch the selected Tab to the top:

- Library Tab
- Layers Tab
- History Tab
- Cut Tab
Anti-Aliased

The **Anti-Aliased** drawing mode is a higher quality mode that creates a much smoother look for vector graphics. Unchecking this option will switch into the standard drawing mode, which is slightly faster for wireframe drawing.
**Refresh**

Use this selection to redraw everything on screen. This command doesn't change anything; it merely refreshes the screen image. Sometimes after you've erased or moved something on screen, you'll notice that certain areas of the screen might not look proper - you might notice some "garbage" left behind from the last command you used. In those instances, you can use the Refresh command to redraw everything on screen again.
Show Fill Colors

Displays fill colors.
Show Grid

When Show Grid is selected a series of dots will be displayed in the background. You can change the size of the grid points by selecting Grid from the Tools menu. You can then enter the increments for both the Horizontal and Vertical axis. Once you select OK, the grid will be display with the new information. You can also select Snap to Grid, which will only allow you to move an object from one grid point to the other.
Show Guidelines

The Show Guidelines command is selected, the guidelines are hidden or shown, depending on whether the command was checked or not. If it was previously checked, then the guidelines will be hidden, and if it was not checked, the guidelines will be shown. The guidelines are always active whether or not they are shown.

Using Guidelines
Show Rulers

This option will show or hide the rulers on the top and right side of the workspace window. Note that you must have the rulers on to create guidelines.
**Show Loop Direction**

The Show Loop Direction command is a toggle command, meaning that when you select this command, the loop direction will be displayed if it isn't already, or it will be turn off if it is displayed.

A loop is one continuous series of lines and arcs that make up a character or logo. The direction of the loop is displayed in two colors; Blue is clockwise, Red is counterclockwise. The direction of a loop is only important when using a router tablet or inline/outlining something. Let's take the letter "A", the inside should be drawn first in a counterclockwise direction (RED), while the outside should be drawn in a clockwise direction (BLUE).

To change the loop direction simply select the Loop Icon on the left hand side of the window, then double click and hold the mouse button on the loop you wish to change. The loop menu will then be displayed, and then you simply select the first option "Reverse Direction".
Show - Show Info Bar

Select this command to turn off or on the information bar at the bottom of the screen.
Show - Show Help Bar

Select this command to turn off or on the help bar at the bottom of the screen. Once you know how LLumar Precision Cut 4 works you probably don't need the help messages, so turning the bar off will make your workspace larger.
Highlight Small Vectors

This is an option that can be helpful in diagnosing data problems with patterns, fonts, graphics, or imported files.
This graphic shows small vectors highlighted in red around the corners of this pattern.
Layout Menu

Guides commands

The commands in the Guides menu (part of the Layout menu) are used to create guidelines that perfectly match the boundaries of an object. This screenshot shows the result of adding guides along the four edges, using the Add Guide Long Top/Bottom/Left/Right Edge commands.

And this screenshot illustrates using the Add Guide at Text Cap Height and Add Guide at Text Baseline commands.

The six commands in the Guides submenu are as follows:

Add Guide at Text Cap Height
Adds a guide at the text object’s cap height position

Add Guide at Text Baseline
Adds a guide at the text object’s baseline position

Add Guide Along Top Edge
Adds a guide at the upper boundary of the object

Add Guide Along Bottom Edge
Adds a guide at the lower boundary of the object
Add Guide Along Left Edge
Adds a guide at the left boundary of the object

Add Guide Along Right Edge
Adds a guide at the right boundary of the object
Shapes

Rectangle

The Rectangle tool lets you create a rectangle, where the width and height are adjusted independently.

Click and drag to the size you want and then release the left button.

Note: Use Alt when dragging a rectangle to force modal mode and keep the tool active after creating a rectangle, if the modal tool option is not enabled in Options, Tools.
**Rounded Rectangle**

The **Rounded Rectangle** tool is a specialized version of the **Polygon** tool. See that tool for more information.
Square

The **Square** tool creates a perfect square from the center of the cursor. If you need the width and height to be different, use the **Rectangle** tool.

Click and drag to the size you want and then release the left button.
Circle

The Circle tool creates a perfect circle centered at the cursor.

Click and drag to the size you want and then release the left button.
Half Circle

The **Half Circle** easily creates a half circle, shown below. You can rotate it after creating it to suit your requirements.

Click and drag to the size you want and then release the left button.
The **Ellipse** tool creates an ellipse, where the extents are determined by the size of the box you draw with the mouse.

Click and drag to the size you want and then release the left button.
Half Ellipse

The Half Ellipse tool creates a half ellipse shape, as shown below. Click and drag to the size you want and then release the left button.
**Polygon**

The **Polygon / Rounded Rectangle** tool allows you to create a polygon with any number of sides, such as a pentagon (5 sided) or octagon (8 sided). When you select this command, the program initially creates a polygon, and then a property box appears so that you can fine tune the parameters using the property bar shown below. You can also round the corners using the Radius setting, and create stars by dragging the handles that appear in the middle of each side. Below is an example of what you can create with this flexible tool:

Here is a description of the property bar:

**Height**

Enter the total height of the polygon here.

**Width**

Enter the total width of the polygon here.

**Radius**

Enter the radius of the corners here.
First Inline

This is the size of the first inline.

Second Inline

This is the size of the second inline.

Number of Sides

Enter the number of sides of the polygon here.

Polygon Mode

Check this off to turn this into a normal graphic, which then lacks any automatic corner regeneration.

Alter Aspect Ratio

Check this to make the stretch or shrink the polygon.

Notched Corners

Check this to use notched corners.

Rounded Corners

Check this to use rounded corners.

Create Separate Objects

Use this button to create two separate objects from a polygon or rounded rectangle that has two inlines and you the inner inline to be a separate object from other two shapes.

Scaled

This option controls what happens when you scale the graphic. In Scaled mode, the corner radius and inline amounts will scale along with the total width and height of the object, the way simple graphics work. In non-Scaled mode (the default), when you scale the object (interactively, or by changing the width or height in the property bar), the radius and inline amounts retain their absolute values and do not change.

Immediate Change Mode

This option causes all changes to the text fields to take effect immediately. With this disabled, you must press Enter to see the changes.
LLumar PrecisionCut 4
The **Arrow** tool creates arrows of various shapes, giving you control of every aspect of the arrow shape, with various handles you can click and drag.

All of the handles on the edge change the shape at that point (symmetrically), while the two center handles provide for moving and rotating.
**Rotate commands**

The **Rotate** commands provide a quick way to rotate an object or a group at clean 45 degree increments.

The Rotate menu has the following commands:

Reset  Reset the rotation to the original value.

\[45\] +45 degrees

\[90\] +90 degrees

\[180\] 180 degrees

\[45\] -45 degrees

\[90\] -90 degrees

A faster way to access the rotation options is through the Rotate Toolbar:

![Rotate toolbar]

To use this toolbar to rotate your objects and groups, just select the object or group and click on the appropriate icon in the toolbar.

To show this toolbar (if it is not already visible), go to the View Menu and select Toolbars, then go down and click on Rotate.

There are two additional options included here, which are

Mirror Horizontally

Mirror Vertically
Layout Properties

The Layout Properties can be accessed through this menu item, as well as by double clicking on the layout (with nothing selected).

**Layout Size**

Height and Width of the layout.

**Grid Size**

Horizontal and Vertical dimensions of the Grid.

**Default Layout Size**

Click on this icon to save the current settings as defaults, which will come up whenever you start the program or select the New command.

**Show Grid**

Click on this icon to turn on the grid display, which will show up as small dots on the layout screen. These are only displayed on the screen and won’t print or plot.

**Snap to Grid**

Click on this icon to enable objects and groups to snap to the grid automatically.

**Show Guides**

Check this box to turn on the guideline display.

**Snap to Guides**

Check this box to turn on Snap to Guides.

**Lock Layout Size**

Prevents the interactive layout resize handles from working.
Snap to Grid

The Snap To Grid command when selected, will only let you drag or move something from one grid point to the other.
Snap to Guidelines

If Snap to Guidelines is checked in the menu, then objects will attach themselves to the guideline when close enough.
Snap Dimensions to Graphics

This option will turn on and off the snapping of guidelines to the rectangular boundaries of graphics in the layout. You can type in an exact dimension in the property bar when this option is unchecked and you know the exact dimension required.
Selectable Guidelines

Use this toggle command to allow guidelines to be selectable when a graphic and a guideline are both under the cursor. This option only applies to the Vector Edit tool and the Layout tool. All other tools prevent guidelines from being selected when in use.
Auto-Square

With Auto-Square checked, when editing vectors, if you are within the Snap Angle, a line will be automatically placed parallel to the X or Y-axis.
Arrange Menu

Align

Use the commands on the Align menu to align objects with each other or with the layout itself.

**Align - Left, Center, Right**
Aligns the objects to the left, center or right boundary. For a text object, the alignment is changed only.

**Align – Top Edge, Bottom Edge, Vertical Center**
These commands align the objects to the top, bottom or vertical center of the group.

**Align – Horizontal Center, Vertical Center, Center of Layout**
These commands align the objects with respect to the layout itself.

**Stack**
This command will align the objects to a common center point, so they all appear on top of each other. This is only useful with shapes that have nothing in the center.
Distribute

**Same Spacing Vertical**
This will set the vertical space between graphics in a group to be the same, while keeping the current height of the group the same.

**Same Spacing Horizontal**
This will set the horizontal space between graphics in a group to be the same, while keeping the current width of the group the same.
The Step & Repeat command allows you make multiple copies of an object or group on the table very easily. The various parts of the Step & Repeat dialog box are described below:

**Copies**
Enter the total number of copies you need in this text box. When you enter a number here, the X Repeats and Y Repeats fields are updated to reflect how the copies will be laid out, so as to be best utilize the available material.

**X Repeats / Y Repeats**
Enter a number in here if you when want to manually layout the copies. The value represents the number of copies you want horizontally and vertically.

**X Margin / Y Margin**
This field specifies the distance between each copy.
Group

Ungroup

Select Ungroup when you no longer want multiple parts to be treated as one unit.
Ungroup All

This command will ungroup all objects in the layout with a single command. Clipping paths are also ungrouped if you wish.
Make Group

The **Group** command will turn a selection into a group. This is unnecessary if you have the Auto Grouping option enabled, except when using Select All.
Group All

This command will make one group out of all the objects in the layout.
**Group Layer**

Use this command group all objects in the layer currently selected in the Layers palette, or the layer of the currently selected graphic.
Locked

This command will lock the select object in place, so that you don’t accidentally move it or delete it.
Editable

This option will toggle the **Editable** flag for a graphic. This is useful when you want to prevent an object from being edited. You can select non-editable objects with the Layers tab and the select Editable to re-enable editing.
Scaling Locked

This command will keep you from being able to Scale an object or group. Even though there are eight control points around an object, only two will work with Scaling Locked checked in this menu: Rotate (lower middle) and Slant (upper middle). The normal Scale, Extend/Condense, and Heighten control points will simply function for selecting and moving. There is another command called Slanting Locked, which disables Slant, the upper middle control point.

Both of these commands are intended to keep the user from inadvertently adjusting the size and/or shape of a pattern object.

All patterns have both of these options checked as defaults, and the user can uncheck them if required. Texr objects do not have these defaults turned on.

The Easy Editor will function on an object even if one or both of these options are checked.
Slanting Locked

This command will keep you from being able to Slant an object or group. There is another command called **Scaling Locked**, which disables Scaling in a similar manner.

Both of these commands are intended to keep the user from inadvertently adjusting the size and/or shape of a pattern object.

All patterns have both of these options checked as defaults, and the user can uncheck them if required. Texr objects do not have these defaults turned on.

The Easy Editor will function on an object even if one or both of these options are checked.
Break into Loops

This command will break the selected graphic into loops, including inner loops. An "inner loop" is the middle of an "A" or the two loops inside a "B," for example.
Break Into Outer Loops

The **Break Into Outer Loops** command will take the selected object and make each loop a new object, which, for example, could be colored independently of the other loops. Use this command if you want to color a multicolored logo. This is similar to **Break Into Loops**, except that inner loops are kept with the enclosing outer loop.
Combine

The **Combine** command will take a group of individual parts and merge them into a new part. You must select the **Undo** command if you wish to return the parts to their original state. Note: Combining should not be confused with **Grouping**. Grouping just groups parts together temporarily, while Combine actually merges multiple parts into an entirely new part.
Close All Loops

This command will close all open loops in the select graphic.
Remove All Inner Loops

This command will remove all inner loops from the selected graphic.
**Horizontal Mirror**

This command will allow you to mirror an object horizontally, in the workspace or in the table.
**Vertical Mirror**

This command will allow you to mirror an object vertically, in the workspace or in the table.
Z Order - Move to Layer

This command allows you to move an object to any layer without having to drag and drop in the layers list, which can be difficult with very complex layouts.
Z Order - To Top

This will enable you to move the selected object to the top of the layers (z-order).
**Z Order - To Bottom**

This will enable you to move the selected object to the bottom of the layers (z-order).
Z Order - Move One Up

When there are many overlapping objects in the layout, use Move One Up to move a selected piece up one layer.
Z Order - Move One Down

When there are two or more objects in the layout that are overlapping, use Move One Down to move a selected piece down one layer.
Text

Text Tool

Test can be entered directly into the layout by accessing the Text Tool in one of three ways:
1. Selecting Text Tool from the Text Menu.
2. Clicking on the A icon from the toolbox on the left of the screen.
3. Pressing the F8 shortcut key and then clicking in the layout where you want to start typing.

The parameters of the text are controlled in the Text Property Bar that goes across the top of the screen. The rest of this section will describe these parameters.

Font

The font box displays the current font in use. To select other fonts, press the arrow button located to the right in the font box. A font display box will appear and additional fonts can be viewed and highlighted for selection. To choose another font, press the new selection in the display box.

Height

The height box allows the height of the line of text to be adjusted.

Length

The length box allows the length of the line of text in the text box to be adjusted. When the Alter Aspect Ratio has been selected any changes to the length will result in a change to the Ext/Cnd value, and the height will stay the same. If an adjustment is made to the length without the Alter Aspect Ratio selected, the height will be adjusted to show the largest letter that can be displayed without changing the Ext/Cnd value.
This special button lets you set where the X,Y position of an object is mapped, for example, the center, lower left, or lower right.

**Alter Aspect Ratio**

By selecting the Alter Aspect Ratio option, you can change the height and length independently of each other.

Normally, when you change the height of any line of text, the length will also change in mathematical proportion to keep the font looking basically the same. However, when the Change Aspect Ratio is selected, and you change the height of any line of text, the length will stay the same and the Ext/Cnd. percentage adjusts accordingly. In this way the shape and size of the font can vary dramatically.

**Align Left**

Click this to align a group of text left justified.

**Center**

Click this to align a group of text centered.

**Align Right**

Click this to align a group of text right justified.

**Live Spell Checking**

This option enables or disables live spell checking. When enabled, the misspelled words are underlined in red and you can Ctrl+Right click over the red line to bring up a menu of suggested corrections to the word(s).

**Extend or Condense (X Scale)**

The extending/condensing box allows for adjusting the length of a line of text in the text box while maintaining the current height. The value of 100% in the ext/cnd box means that the text has not been extended or condensed. The value of 150% in the box means that the line of text is 50% longer than its original length and the value of 75% means that the line of text was condensed 25%.

For good quality sign design, it is helpful to remember that most letter styles should not be extended or condensed more than 15 - 20%. If it is necessary for more extending/condensing of the letter style to fit the shape of the sign then a better option would be to select a font that is already more extended or condensed to fit that need.

**Letter Spacing**

The Letter Spacing box determines the percentage of space between each letter.

**Word Spacing**
The Word Spacing box determines the percentage of space between each word.

**Line Spacing**

The line spacing box determines the amount of spacing between lines in inches. LLumar Precision Cut 4 will automatically adjust this value when the height has been changed. The default is 40% of the height of the larger of current and previous lines.

**X Position**

The X Position box determines the location of the line of text horizontally. If the text is left justified the beginning position is at the lower left. Center justified means that the beginning position is at the center of the text. Right justified means that the beginning position is at the lower right.

If your sign is 30 inches long and the X Position is set at 5, then wherever the text is justified, the line of text will shift 5 inches over from that beginning point.

The default for this box is 0. If you do not change the X location, all the lines of text that you have placed in the text box can be dragged around on screen so that you can select the location of the text.

**Y Position**

The Y Position box determines the location of the line of text vertically. If your sign is 10 inches tall and the Y Position is set at 2, then the line of text will move 2 inches vertically.

The default for this box is 0. If you do not change the Y location, all the lines of text that you have placed in the text box can be dragged around on screen so that you can select the location of the text.

**Slant**

The slant box determines the positive or negative degree of slant for the line of text in the text box.

**Rotation**

This button displays the rotation in degrees of the object.
Break Apart

The **Break Apart** command will break up a line of text into individual characters. This can be a handy feature if you wish to increase the size of one character without effecting the rest of the line. You can re-group the characters and select Convert to Text (see below), and this will turn the individual characters into a line of text.
Live Spell Checking

When Live Spell Checking is enabled, all letters that are part of a misspelled word are underlined in red.

To correct misspelled words, hold down Control when right clicking on the misspelled text. A menu will pop up, giving you the following options:

**Suggested Words**

As many suggestions as were found will be listed. To use one, simply select it from the menu and the text will be changed. This is undoable.

**Ignore All**

Select this to ignore all occurrences of this word. It will be added to the ignore list.

**Add To Dictionary**

Select this to the add word to the user dictionary.
Convert to Text

Once you have broken up a line of text, you can select a group of characters and then select the Convert to Text command. This will take the characters you have selected and convert them into a line of text. If you have selected characters that are made up of different attributes, the line of text will be changed to reflect the attributes of the first character in the group.
Change Copy

Enter the new copy for the selected line of text. If you press the Ok button, your selected text line will be completely regenerated, and will lose any special distortions that may have been performed on it, such as Offset or Perspective. Also, you will lose any special letter-pair kerning you entered on the line.
**Change Case**

Use this command to change the case of text to one of the following options:

1. lowercase
2. Capitalized
3. Sentence case.
4. SMALL CAPS
5. UPPERCASE

The keyboard shortcut Alt+C will cycle through the Change Case options in the order above, immediately updating the text so you can see what it looks like.
Text on a Path

This very useful text tool lets you easily set text to a path, while keeping each character intact, as opposed to Warp, which modifies the shape of each character when warping. The property bar has the following options:

Curve Compensation

This very useful option lets you vary how the letters are spaced when going around sharp bends. It defaults to 6%. Adjust the setting to see how it works.

Add Curve

Press this button to add a new curve to the end of the path

Delete Curve

Press this button to delete the last vector in the path.

Bezier

This converts the selected vector in the path to a bezier curve.

Arc

This converts the selected vector in the path to a circular arc.

Remove

Removes the effect from text. For other graphics, it undoes the effect.
Font Layout

Use this command to create a layout containing all the characters in a font, which can then be printed for easy reference.

Fonts

Select the font from this list. A preview of the selected font will appear below the list.

Width

Enter the width of the page you want to print on. Default: 11 (inches).

Height

Enter the height of the page you want to print on. Default: 8.5 (inches)

Line Break Characters

Enter the letters that you want to start each line in the layout, except for the first line, which always starts with capital "A". This will determine the overall arrangement of the font characters.

After you press Ok, a layout will be created that contains all the characters in the selected font, arranged according to the Line Break Characters above. The name of the font will also be placed at the top of the letters, which you can resize or move as desired.
Vertical

Use this command to turn a text object into a vertical text object, which displays the text vertically instead of the usual horizontal. Most of the normal editing methods still apply except the text handles are shifted –90 degrees down.
Connect

Connects the letters of a connecting script font into a single script word, except for capitals.
The Outline command will add an outline or inline to the selected object. You have the option of combining the outline with the original object or leaving it separate so you make the outline a different color from the original.

1st

This is the value of the first offset in inches or millimeters.

1st %

This is the first offset as a percentage of the height of the character.

2nd

This is the value of the second offset, which is based on the first offset’s path, that is, it’s a relative value. This can be negative.

2nd %

This is the percentage corresponding to the 2nd offset, above.

OAT (Outside Angle Threshold)

This angle can be set at any value between $1^\circ$ and $90^\circ$. When offsetting any loop, if the angle between two vectors is less than the Outside Angle Threshold, a circular arc will be drawn to connect the vectors.

Leave Original

If this is checked the original object will be left after the outlining is finished. If it is not checked, the original object will be deleted after the outlining.

Contour

If this option is checked, only the outer clockwise loop(s) are retained and any inner loops are deleted. This is useful when color printing on vinyl where an outline cut path is needed.

Combine
If this option is checked, the offset object is combined with the original and they become a single object. If neither this option nor the Leave Original option is checked, the original object is deleted and only the offset object remains. If this option is not checked and the Leave Original option is checked, the original object and the offset object are both retained, but they are two separate objects.

**Combine Group**

Check this when outlining a group and you wish to combine the resulting group.

**Group**

This option controls whether the outline is grouped with the original or not, when you press Done to create the outline.

**Preview**

This option enables the new behavior where the full (non-intersecting) outline is created as soon as you release the left mouse button after dragging the outline interactively. If you don't want this, uncheck this box.

**Stroke Preview**

Check this to preview the outline as raster strokes, which is quicker and can better handle large graphics.

**Miter Corners**

Press this to set mitered corners, which sets OAT to a setting that creates mitered corners except in the most extreme angles.

**Round Corners**

Press this to set round corners, which sets OAT to a setting that creates round corners.

Inlining, outlining and offsetting can be done in the outline mode or in the color mode. It is easier to distinguish the character from the outline in the color mode.
Shadow

The Shadow Tool is used when creating shadow effects for vinyl cutting, in which you cannot have overlapping paths, so some special processing must be performed to create shadow proper effects.

Outline

Enter the amount of outline or inline you want to be applied to the shadow. A negative number will cause the shadow to be thinner than the original, thereby creating an overlap between the original and the shadow. This is helpful in avoiding vinyl shrinkage.

%  

This allows you to specify the outline as a percent of the height of the object, just as when using Offset or Inline/Outline commands.

OAT

This determines how rounded corners will be in the final result.

Hs

The horizontal shift for the shadow.

Vs

The vertical shift for the shadow.

3D %

This scales the size of the shadow when using the Perspective Shadow mode. 100% is the same size as the front, 50% is half size, etc.

Preview

Check this to preview the shadow for the entire selection. With this unchecked, only a single letter is previewed.

Drop Shadow

This type of shadow effect leaves the original object intact as part of the underlying shadow. Using this, combined with a negative number in Outline, you can create an overlap between the original and the shadow, which will help guard against the vinyl shrinkage problem. If you
specify a positive Outline, you can create an outline that is merged with the shadow, which produces a striking, bold effect.

**Shadow**

Relief Shadow

This type of shadow will actually "cut out" the original object's shape from out of the shadow object. This is most useful when you want to leave a visible gap between the shadow and the original. In most other cases, Drop Shadow is the preferred option to use.

**Shadow**

Extruded Shadow

Check this option to enable the extruded mode.

**Shadow**

Perspective Shadow

Check this option to enable the perspective mode.
Cast Shadow

Check this option to create a cast shadow. The Vs field now sets the height of the shadow and the Hs field sets the angle, but it’s really a horizontal shift at the top of the graphic only.
Shadow

The **Shadow Tool** is used when creating shadow effects for vinyl cutting, in which you cannot have overlapping paths, so some special processing must be performed to create shadow proper effects.

**Outline**

Enter the amount of outline or inline you want to be applied to the shadow. A negative number will cause the shadow to be thinner than the original, thereby creating an overlap between the original and the shadow. This is helpful in avoiding vinyl shrinkage.

% 

This allows you to specify the outline as a percent of the height of the object, just as when using Offset or Inline/Outline commands.

**OAT**

This determines how rounded corners will be in the final result.

**Hs**

The horizontal shift for the shadow.

**Vs**

The vertical shift for the shadow.

**3D %**

This scales the size of the shadow when using the Perspective Shadow mode. 100% is the same size as the front, 50% is half size, etc.

**Preview**

Check this to preview the shadow for the entire selection. With this unchecked, only a single letter is previewed.

**Drop Shadow**

This type of shadow effect leaves the original object intact as part of the underlying shadow. Using this, combined with a negative number in Outline, you can create an overlap between...
the original and the shadow, which will help guard against the vinyl shrinkage problem. If you specify a positive Outline, you can create an outline that is merged with the shadow, which produces a striking, bold effect.

Shadow

Relief Shadow

This type of shadow will actually "cut out" the original object's shape from out of the shadow object. This is most useful when you want to leave a visible gap between the shadow and the original. In most other cases, Drop Shadow is the preferred option to use.

Shadow

Extruded Shadow

Check this option to enable the extruded mode.

Shadow

Perspective Shadow

Check this option to enable the perspective mode.
Cast Shadow

Check this option to create a cast shadow. The Vs field now sets the height of the shadow and the Hs field sets the angle, but it’s really a horizontal shift at the top of the graphic only.
Shadow

The **Shadow Tool** is used when creating shadow effects for vinyl cutting, in which you cannot have overlapping paths, so some special processing must be performed to create shadow proper effects.

### Outline

Enter the amount of outline or inline you want to be applied to the shadow. A negative number will cause the shadow to be thinner than the original, thereby creating an overlap between the original and the shadow. This is helpful in avoiding vinyl shrinkage.

%  

This allows you to specify the outline as a percent of the height of the object, just as when using Offset or Inline/Outline commands.

### OAT

This determines how rounded corners will be in the final result.

### Hs

The horizontal shift for the shadow.

### Vs

The vertical shift for the shadow.

### 3D %

This scales the size of the shadow when using the Perspective Shadow mode. 100% is the same size as the front, 50% is half size, etc.

### Preview

Check this to preview the shadow for the entire selection. With this unchecked, only a single letter is previewed.

### Drop Shadow

This type of shadow effect leaves the original object intact as part of the underlying shadow. Using this, combined with a negative number in Outline, you can create an overlap between the original and the shadow, which will help guard against the vinyl shrinkage problem. If you
specify a positive Outline, you can create an outline that is merged with the shadow, which produces a striking, bold effect.

**Shadow**

**Relief Shadow**

This type of shadow will actually "cut out" the original object's shape from out of the shadow object. This is most useful when you want to leave a visible gap between the shadow and the original. In most other cases, Drop Shadow is the preferred option to use.

**Shadow**

**Extruded Shadow**

Check this option to enable the extruded mode.

**Shadow**

**Perspective Shadow**

Check this option to enable the perspective mode.
Cast Shadow

Check this option to create a cast shadow. The Vs field now sets the height of the shadow and the Hs field sets the angle, but it’s really a horizontal shift at the top of the graphic only.
Shadow

The **Shadow Tool** is used when creating shadow effects for vinyl cutting, in which you cannot have overlapping paths, so some special processing must be performed to create shadow proper effects.

<table>
<thead>
<tr>
<th>Outline: 0.3034</th>
<th>%: 3%</th>
<th>OAT: 70</th>
<th>Hs: -0.8403</th>
<th>Vs: 0.8334</th>
<th>3D %: 75%</th>
<th>Preview</th>
</tr>
</thead>
</table>

**Outline**

Enter the amount of outline or inline you want to be applied to the shadow. A negative number will cause the shadow to be thinner than the original, thereby creating an overlap between the original and the shadow. This is helpful in avoiding vinyl shrinkage.

%  

This allows you to specify the outline as a percent of the height of the object, just as when using Offset or Inline/Outline commands.

**OAT**

This determines how rounded corners will be in the final result.

**Hs**

The horizontal shift for the shadow.

**Vs**

The vertical shift for the shadow.

**3D %**

This scales the size of the shadow when using the Perspective Shadow mode. 100% is the same size as the front, 50% is half size, etc.

**Preview**

Check this to preview the shadow for the entire selection. With this unchecked, only a single letter is previewed.

**Drop Shadow**

This type of shadow effect leaves the original object intact as part of the underlying shadow. Using this, combined with a negative number in Outline, you can create an overlap between
the original and the shadow, which will help guard against the vinyl shrinkage problem. If you specify a positive Outline, you can create an outline that is merged with the shadow, which produces a striking, bold effect.

**Shadow**

**Relief Shadow**

This type of shadow will actually "cut out" the original object’s shape from out of the shadow object. This is most useful when you want to leave a visible gap between the shadow and the original. In most other cases, Drop Shadow is the preferred option to use.

**Shadow**

**Extruded Shadow**

Check this option to enable the extruded mode.

**Shadow**

**Perspective Shadow**

Check this option to enable the perspective mode.
Cast Shadow

Check this option to create a cast shadow. The Vs field now sets the height of the shadow and the Hs field sets the angle, but it’s really a horizontal shift at the top of the graphic only.
**Weld**

The **Weld** command simply eliminates any overlapping paths, so the resulting is cuttable. In the example below, the top graphic has overlapping paths, and the bottom is the result of using Weld, which will have no problems with cutting.
Warp

The **Warp Tool** will take a graphic and fit it to the shape that you create. See examples below.

**Lines Only**

Check this to restrict what you can change. With this checked, the two middle handles on each side will move to keep the edges straight lines. With this unchecked, they will stay put if you move the two ends of the bezier, thus creating a curve when you might not want a curve.

**Drop down listbox**

This box shows all the prior warps you’ve saved, which you can use again with just a click in the list. They can be adjusted further, of course.

**Save Preset**

Press this to save the current warp for future use. Warps are saved using generic coordinates, so that when applied to graphics of different aspect ratios, the warp effect appears similar.

**Delete Preset**

This will delete the current saved warp, that is, the warp that’s shown as selected in the drop down list box above.

**Remove**

Remove the selected preset with this button.

**Using the Warp Tool**

Once you select Warped, the selected object(s) will be displayed with a bounding box, with four control points on each side, as shown below.

The middle two controls points on each side are Bezier Curve control points and can be shaped into any figure. The control points in each of the corners are straight lines and can also be move to create a number of different shapes.

In this example, two of the control points were dragged up to create a wave effect.
Once you have moved the control points to create the desired shape, you double click the left mouse button to see the "warped" effect. If the new shape is not correct, simply select the Undo command from the Edit menu.
**Sphere**

The **Sphere** command causes the selected object to be wrapped around a sphere. When the tool is activated, drag a circle, representing a sphere, with the center near the center of the graphic, and you will see the sphere effect immediately as you drag the mouse.

The **Sphere** property bar has the following options:

**Distance**

This value specifies how far away the viewer (you) will be from the sphere. So, a small value, such as 1 or 2, will mean the sphere appears very warped, while a larger value like 5 will decrease that effect.

Select Done to end the tool or Esc to cancel.
Cylinder

The **Cylinder** command causes the selected object to be wrapped around a cylinder.

When the tool is activated, drag the width of the cylinder left or right and see the effect immediately.

The **Cylinder** tool is now one of the Dynamic Effects, meaning it’s able to work with text such that changing the font, spacing, etc on a text object will cause the Cylinder effect to be recreated and text remains as text!

The **Cylinder** property bar has the following options:

**Distance**

This value specifies how far away the viewer (you) will be from the cylinder. So, a small value, such as 1 or 2, will mean the sphere appears very warped, while a larger value like 5 will decrease that effect.

Select Done to end the tool or Esc to cancel.
Cut

Add to Table

Adding objects or groups to the Cut Table can be done in several ways. In each case you must first select the object or group.

1. Select Add to Table from the Cut Menu.
2. Use the shortcut key A.
3. Double click on the object or group.
4. Drag the object or group down into the Cut Table.
5. Hold down SHIFT while you select an object or group.

When an object is added to the table, its outline will turn green in the main layout to help you keep track of what is on the table and what is not. If you add a group to the table, all of the individual objects of that group will turn green.

Once an object is on the table, it can be removed with the Delete key of by selecting Delete from the Edit Menu. Deleting an object from the Cut Table does not delete the original corresponding object from the main layout, but it will turn that outline black again.
**Layout**

**Cut Table**
- Click and drag
- Double click
- Shortcut key “A”
Auto Nest

The new Auto Nest feature makes it easy to create efficiently nested patterns that will save you material and cost.

To use Auto Nest, first add the elements from the pattern that you want to nest onto the table (remember that you can create several tables per pattern). Then select Auto Nest from the Cut Menu or simply click on the Auto Nest button in the Cut Tab on the lower right of the screen.

The feature will take each of the objects on the table and efficiently position them, using rotation if beneficial, to achieve a tight nest.

There are two important user options that you can change as needed:

1. Nest Padding - this determines how close two objects can be on the table. The factory default is 0.25" and you can make this value larger or smaller. The Nest Padding value is in the Cut Tab for easy access.

2. Auto Nest Rotations - the factory default is 8, meaning that objects can have 8 rotation options: 0, 45, 90, 135, 180, 225, 270, and 315 degrees. If you make the value smaller, such as 4, then you will have four rotation options: 0, 90, 180, and 270 degrees. This will result in faster operation of the feature. If you make the value larger, such as 12, then you will have 12 rotation options and the feature will be a little slower. The actual impact on the final nest is determined by the objects to be nested. ** Please note that Window Film can only be rotated in plus or minus 45 degree increments.

If you add a Group to the table, you can choose to maintain the Group on the table, meaning that the individual pieces will not be nested. This may be preferable in cases where the original pattern has a nested pattern, and it isn't worth a modest increase in efficiency to have the
pattern elements distributed around the table. To maintain the position of the elements in a Group, select the Group on the table by drawing a box with the left mouse button and then use the Prenested command, either from the Cut Menu or with the shortcut key "P." Please see the topic on the Prenested command.

In this example on the right, the Lotus Elise, the front hood, fenders, and mirrors are fairly well nested in the original pattern. This Group has a height of 55", so it is good for a 60" width material.

Additionally, after the Auto Nest routine is finished, you then have the option to further optimize the nesting through changes in the position and/or rotation of each object. Remember that when working with objects on the Cut Table, you can use the arrow keys on the keyboard to move objects, and you must hold down the CTRL key if you want to move and/or Rotate an object over another one. You may also use the Prenested command after the initial nesting.

Here is an example of a nested pattern: Volkswagen Touareg 2 V8, 2008-2010

At the bottom of the screen in the Status/Help Bar, you'll see the Width, Length, and Square Feet of the material used for the nesting, as well as the Efficiency, which is a calculation of the area that is being covered by pattern objects divided by total area. The higher the Efficiency, the more optimal the use of the material.
**Prenested**

The **Prenested** command will designate an object or group as "immune" from the Auto Nest routine, meaning that its position will not be changed. You can either select Prenested from the Cut Menu or use the shortcut key "P" to execute this command.

There are three ways to use this command:
1. Adding an already well nested group from a pattern to the Cut table.
2. Prepositioning an object or group on the Cut table where you want it in the final nesting.
3. Revising the results of an Auto Nest by moving/rotating one or more objects to a more efficient position and re-running the Auto Nest command.

A Pre-nested object or group will be converted to a dotted line so that it is clear which objects are pre-nested and which objects are not.

Here is an example of a window tint pattern that is "well nested" already, and likely wouldn't greatly benefit from the Auto Nest command. There are many such similar patterns in the Window Tint database. This group of six windows was added to the cut table and designated as "Prenested," which turns the paths into dotted lines. The squares inside each object indicate that this is a group on the table. If you continue to add additional objects to this table and then run the Auto Nest function, this group will remain as is, and the other elements will be nested around it.

Here is an example of a paint protection pattern where a group of prenested front bumper elements was added to the table, as well as additional objects. In the final nesting, you can see the prenested group with the dotted outlines in the lower left corner where it was originally positioned.
Finally, here is an example where you have a sub-optimal auto nest, and it is clear that by moving one object to a better location, the final nest would be more efficient. So all you have to do is move/rotate the outlying object to where you want it, mark it as "prenested" with the P shortcut key, and run the Auto Nest routine again.
Start/Stop/Abort/Delete

Start will send the nested patterns on the Cut Table to your plotter/cutter.
Weed Borders

This dialog box lets you set the weed border size.
Weed Borders

This dialog box lets you set the weed border size.
Setup

LLumar Precision Cut 4 has an open driver architecture that allows you to edit commonly changed parameters, as well as more advanced ones. It is important that you understand what you're doing if you choose to make changes to the advanced settings. Please also see the information on the Cut Tab for more basic settings for cutting and plotting. Here is an example driver for the Graphtec FC7000 series cutter.

In common usage with standard machines, there is no need to go into this dialog box and make changes. Modern cutters allow some of these parameters to be set/changed directly on the machine, such as Set Origin, Plot/Cut Speed, and Knife Offset. Please consult the documentation before making changes to the items in this dialog box.

With all these disclaimers in place, here are descriptions for the items in the open driver.

Port

Select the computer port that your plotter is connected to.

Name

Entering a new name if you wish to make changes to an existing driver is a very good idea.

Page Length
Enter the maximum distance that the plotter can plot in a single panel. This limit is usually related to how large the numbers can be for your machine. 32000 is a typical limit. Consult your plotter's manual for details.

**Plot Speed**

Enter the speed (in inches per second) that you want your machine to PLOT at. Consult your cutter's manual for the proper range of values to enter here. This value may be faster or slower than the CUT speed.

**Cut Speed**

Enter the speed (in inches per second) that you want your machine to CUT at. Consult your cutter's manual for the proper range of values to enter here. This value may be faster or slower than the PLOT speed.

**Media Height**

Enter the total width of the material that you will be using. This value can be over-ridden by the value entered in the Cut Tab or from the function Poll Material Width.

**Units / Inch**

Enter the number of units per inch the plotter uses. 1016 is standard on HPGL-compatible plotters.

**Knife Offset**

Enter the knife offset required by the plotter to produce sharp, closed corners. Some plotters use a swiveling knife, and don't require a knife offset. The plotters known as "castering" or "trailing knife" plotters would require this. Enter 0 if your plotter doesn't require an offset. Otherwise, consult your plotter's manual for details on this value.

**Separator**

Use this to separate each move or line. The commonly used separators are semi-colon or carriage-return and line-feed.

**Min. Chord Len**

Enter the smallest chord that should be created when bezier curves are broken into lines for plotting.

**Max. Chord Len**

Enter the longest chord that should be created when bezier curves are broken into lines for plotting.

**Min. Angle**
Enter the angle (in degrees) that should be used to calculate the optimal size of the chords when bezier curves are broken down into lines for plotting.

Poll Width

This command checks the available width of material loaded into the machine.

Plot Init

Enter the plotter's initialization string for plotting here.

Cut Init

Enter the plotter's initialization string for cutting here.

Move

Enter the plotter's command to lift the cutter or pen and move it to a new position. Preserve the "%ld,%ld".

Line

Enter the plotter's command to plot a line from the current pen or knife position to a new position. Preserve the "%ld,%ld".

Arc

Enter the plotter's arc command (if it has one). In this field, the following special character sequences are used:

Characters Meaning

%\text{x} x-center of arc
%\text{y} y-center of arc
%\text{a} degrees in arc
%\text{A} degrees in arc x 100
%\text{X} x-end of arc
%\text{Y} y-end of arc

Set Origin

This command is sent to the plotter whenever the origin (0,0) needs to reset to a new absolute position, such as with paneling. Preserve the "%ld,%ld".

End

This string will get sent to the plotter after the plot is finished. You can put anything that is relevant in here.

Set Depth
This is intended for CNC machines.

**First Move**

This is used when the first move needs a special command. This is normally blank.

**Coordinates - Absolute / Relative**

Select the coordinate mode that the plotter must operate in. If the mode is selectable through a command (such as PA with HPGL), make sure that command is placed in the two init strings above (Plot Init and Cut Init).

**Flow Control - CTS/RTS / XON/XOFF**

Select the flow control or handshaking method that the plotter will be using. A common source of problems on longer plots is an incorrect flow control setting. Make sure the plotter is actually set to the method you have chosen here. CTS/RTS is sometimes called hardware or hardwire handshaking, and XON/XOFF is sometimes called software handshaking.

**Cut Mode**

Select this option when you are cutting with the plotter. Turn this off when plotting. This option won't matter if the plotter has a Plot/Cut switch. (In that case, make the sure the Plot Init and Cut Init strings are identical, and the Knife Offset is set to 0.)

Flip Y-Axis
Check this if you need to flip the Y axis.

**COM Port**

These settings are used with serial ports. The most common setting is 9600 for Bits / Sec, 8 for Data Bits, N for Parity, and 1 for Stop Bits. Use these as a safe default.
Poll Material Width

Use this command to automatically set the material height setting in the currently selected plotter driver. When you select this command, LLumar Precision Cut 4 attempts to “poll” or ask the cutter for the size of the material currently loaded. On many plotters, this value represents the actual size of the loaded material; on others, it’s maximum height that the cutter is physically able to cut up to, not the size of the loaded material. See your cutter’s user guide for more information.

Note: This feature is typically only available with HPGL-compatible vinyl cutters.

This is not available with LPT or WPD ports, only COM and USB ports.

Special Node for Roland users:

With Roland devices using USB, there's a special way to do polling. In the driver setup, under "Poll Width", enter the special code "OHRDUSB" and use a WPD port type.
Tools
Options

General

Snap Angle

The "Snap Angle" will determine how many degrees from perfectly horizontal or vertical a vector's endpoint must be for it to "snap" to a perfectly horizontal or vertical position. This only applies if you have the Auto Squaring feature enabled.

Tangency

This setting is in degrees and determines when the tangency indicator will appear when vector editing. For example, if Tangency is set to 4 degrees, any consecutive arcs and lines that are within 4 degrees of perfect tangency will show the tangency indicator (a cross mark) at their common point. If the tangency error is greater than the Tangency setting, a small black box is drawn at the common point.

Proximity

The Proximity setting is used for selecting vectors. If you have a value of 6, the program will look 6 pixels in every direction for the closest vector, then select that vector for your editing.

Millimeters / Inches

These two options specify the units of measure used throughout LLumar Precision Cut 4.

Curve Resolution - Arcs

This option allows you to specify how “smooth” or "coarse" the displayed arcs appear. This affects the display only and does not affect plotting. Using a high setting such as 10 will result in faster operation when dealing data that contains many arcs (such as the Baskerville font). The minimum setting is 1. You may, however, notice that arcs are not broken down into very many segments (chords) if you zoom in very tight on a character making it look “chunky”, but this will not appear in the final plot.

Curve Resolution - Beziers

This option allows you to specify how “smooth” or "coarse" the displayed Bezier curves appear. This does not effect plotting. The maximum setting, which gives the smoothest curves, is 50. Using a low setting such as 8 will result in faster operation when dealing with data that contains many Bezier curves. You may, however, notice with a low setting that curves appear “chunky” because they are not broken down into very many segments, especially when you zoom in very tight on a character, but this will not appear in the final plot.
View

Show Fill Colors, Show Stroke Colors, Show Grid, Show Rulers, Show Guidelines, Show Loop Direction

Each of the above options will make the corresponding menu option startup with that state. However, loading an old layout may change some of these options, since they are stored with the layout file.

Link with Show Strokes

This option means Show Strokes is automatically enabled and disabled when Show Fill Colors is checked.

Draw Strokes Behind Fill

This is the default state for the corresponding button on the Color Property Bar.

Guidelines appear above objects

Check this option to make guidelines appear above all objects. This is helpful if you want to see the guidelines at all times.

Interruptible Display

Turn this option on when you want to be able to interrupt the display refreshing by pressing Esc on the keyboard. Turning this off will speed up the drawing slightly, but you won't be able to interrupt the display refreshing.

Restore Windows

Turn on this option when you want LLumar Precision Cut 4 to remember where you placed the application windows when you close and restart the program. When this is turned off, Windows will determine the best position and size of new application windows.

Extra gap around layout

This refers to the extra gap that can added to a fully zoomed out view of the layout. Note that you can use Alt+Right click to zoom out beyond the layout size.

Preview Time Threshold

This setting determines how responsive the program will be when you manipulate complex graphics. If drawing the graphic in question takes longer than this value (in milliseconds), it will be drawn as a simple box and then updated after about ¼ second of no mouse movement. You can increase the responsiveness of the software by using a value of 50 ms or less.

Refresh Timeout

This value tells the software when it should update the screen if a refresh takes too long. For example, the default of 1500ms (1 ½ seconds), means if that amount of time has elapsed
during a refresh, what’s been rendered so far will be transferred to the screen, and rendering will continue. This will repeat as necessary. This feature makes it clear to the user that rendering is still occurring when the layout is very complex and would otherwise takes many seconds to render, and it might appear that the program has hung.

Mouse Wheel Zoom %:

This is the amount of zoom to perform when the mouse wheel is rotated.

Default Color Space

Select the default ICC profile color space to use.

Default Rendering Intent

Select the default rendering intent for the ICC profile to use.

Enable Color Management

Check to enable ICC color management by default for new layouts.

Extra Fill Pixel Width

This adds some width to all fills.

Fill Open Loops

Check this to fill open loops. Otherwise open loop will not draw filled.

Draw center handles of grouped objects

Select this to show the center handle when grouping objects. This can be distracting so it’s been made optional.

Ignore background color when printing

Select this to hide the background color when printing.
**Edit**

**Auto square**

Use this to automatically create vertical and horizontal lines when vector editing.

**Snap to grid**

Turn this on to snap objects to the grid.

**Snap to guides**

Turn this on to snap objects and vectors to the guidelines.

**Allow auto grouping**

This will automatically create a group when you draw a box around some graphics.

**Use original single level grouping style**

Check this to use the original single level grouping style, which does not use a nested grouping approach.

**Shift box deletes vectors**

This means that when you are editing vectors, and you hold down shift while drawing a box around vectors, they will be deleted. With this unchecked, they will be selected instead of deleted.

**Convert arcs to beziers for EMF**

This option, when checked, tells the program to convert all arcs to bezier curves when: 1) copying a design to the clipboard in the Enhanced Metafile (EMF) format, and 2) exporting a design to the Enhanced Metafile (EMF) format. When unchecked, all arcs are converted to short lines.

**Draw clip groups with dotted lines**

This option lets you choose to have the software draw dotted lines when a group with a clipping path is selected. This can make it easier to see objects in the group that can sometimes be invisible due to clipping.

**Create history log file**

This option will log the actions to a file, which can help in tracking down problems in the software. Turning this off will just reduce the disk activity when using the program and save some disk space.

**Make selection/group by intersecting with object**
LLumar PrecisionCut 4

This option means that when you draw a box to select graphics, you only have to intersect with an object for it to be included in the selection or group.

Select by clicking within bounding box

This option determines whether the program considers a click within the bounding box of a graphic when determining if it has been selected. With this unchecked, you have to select within a filled graphic or on the edge of a graphic to select it.

Image Editing Program

Specify the path to the image editing program you wish to use when you press the Edit button in the Image Toolbar or select Edit from the Image menu. Select Browse to select the folder visually.

Nudge amount

This value refers to the amount of distance an object or vector will be moved when using the arrow keys to "nudge" an object a precise amount instead of using the mouse. Check the In Pixels box to make the software interpret the value in pixels instead of inches/mms.

Update Delay

Many tools use a delayed update scheme to achieve both a responsive operation and full color display. The delay in milliseconds used in these tools can be adjusted to suite your preferences, with this option. 1000 milliseconds equals 1 second. The default is 250 or ¼ second.
Save tab

Auto save

Check this box to turn on the auto-save function. When turned on, you can also specify the number of minutes between saves. The auto-save function saves your file in a temporary file, and if LLumar Precision Cut 4 terminates abnormally and is not allowed to delete this file, then the next time you start LLumar Precision Cut 4 it will detect this file and ask if you want to reload it.

Largest file to Auto Save

This specifies the largest file the system should attempt to auto save. Very large files can cause problems if they take longer to auto save than the auto save interval, not to mention the long pause in the program while it auto saves.

Embedded Bitmap Format

Select the default format for bitmaps embedded in a layout (LYT) file. JPEG will use the maximum JPEG quality (100%), but will still lose a very small amount of detail if you repeatedly save and load the LYT file, because is “lossy”. PNG is losslessly compressed, so no pixel information is ever lost with repeated saves and loads. TIF is uncompressed and will generally save faster with very large files, if you have a fast hard drive. If you are only using bitmaps as reference storefront images, JPEG will be the best choice. If using JPEG, you can force PNG mode with the “Lossless” option button in the Bitmap property bar.

Store thumbnail at start of file

This option changes how the small thumbnail image is stored in a LYT file. Normally it’s placed at the end of the file, but this option causes it to be stored at the beginning, which allows programs like ThumbsPlus to be used as a browser that can launch the program as well.

Enable Windows thumbnail viewing of Layout files

This option makes a small change to the Windows registry to allow Windows to preview and create thumbnails from LYT files. When the above option is checked (Store thumbnail at start of file) is checked, the LYT file is actually a BMP file with Sign Wizard vector added to the end.

Convert arcs to beziers for EMF

This option, when checked, tells the program to convert all arcs to bezier curves when: 1) copying a design to the clipboard in the Enhanced Metafile (EMF) format, and 2) exporting a design to the Enhanced Metafile (EMF) format. When unchecked, all arcs are converted to short lines.

Create backup files

Check this to have the program automatically save your last version as a backup, in case you need to revert back to it. Use the Directories tab to specify the backup folder.
LLumar PrecisionCut 4

Strips to use when Exporting

This specifies how many vertical strips to use when exporting a file. Higher numbers are more memory efficient and allow you to export to larger sizes and dots per inch.

Strips to use when Printing

This specifies how many vertical strips to use when printing a file. Higher numbers are more memory efficient and allow you to print to larger sizes and dots per inch.

Contour Cut Path Color Name

This lets you specify the name of the stroke color your RIP wants to see when interpreting a stroke as a contour cut path and not a regular stroke. Some examples are “CutContour” and “ContourCut”.
Text

Letter Spacing

This box allows you to set the default letter spacing whenever you start LLumar Precision Cut 4.

Letter Height

Enter the default letter height (inches or mm) in this box.

Text Alignment

Specify the default text alignment (as used in the Edit Copy dialog box) here.

Auto Line Spacing %

This percentage controls how the auto line spacing works by taking the height of the taller of the current line and previous line and multiplying it by the Auto Line Spacing % value entered here. This value determines the space between the baseline of the previous line and the cap height of the current line. The factory defaults is 40%.

Auto Line Spacing

Check this to make the program determine the line spacing automatically, using the Auto Line Spacing % value, above, for each line of text, in which the text height determines the line spacing.

Text Auto Grouping

This option enables or disables a new feature in the text editor, in which text that is entered in sequence is automatically grouped. Uncheck this to revert to the old behavior.

Scan TrueType fonts on Startup

Checking this makes sure all your TrueType fonts are seen when the program starts. This will make the program start up slower.

Rebuild Font Index on Startup

Check to make sure all the fonts in the system are seen by the software. This will make the program start up slower. Uncheck this if your fonts aren't changing.

Font Drop Down Length

This is the vertical size, in pixels, of the font list.

Font Drop Down Width

This is the horizontal size, in pixels, of the font list.
LLumar PrecisionCut 4

**Font List Preview Size**

Choose how large you want the font images to be when shown in the font list.

**Auto Zoom Out**

This option enables or disables the feature where the zoom level is automatically changed when entering text that has gone off the screen.
Tools

Shape tools remain active

Check this to make shape tools remain active after creating a shape.

Fill New Shapes

This option fills new shapes with the last used fill color. Prior versions did not do this. Uncheck this to revert to the previous behavior, where shapes are not filled.

On Screen Digitize: Use Control, Shift, Alt instead of menus

Check this to use a new mode for the on screen digitize tool, which uses the shift keys instead of popup menus.

Dimensions - Arrow Size

Specify the size of dimension arrows as a percentage of the height of the layout.

Dimensions - Text Label size

Specify the size of text labels in dimensions as a percentage of the height of the layout.

Dimensions - Number Type

Specify how dimensions labels are drawn (e.g. inches & fractions, inches and decimals, etc.)

Dimensions - Resolution

Specify how precise you require your dimensions to be. For example, if you only need 1/8” precision, enter “8” here.

Dimension Font

Select the font to use for dimensions.

Dimensions – Line Width

This is the default stroke width for dimensions. It’s useful to change the default of 0 (which means hairline or one pixel wide) when printing, if the lines aren’t clearly visible.
LLumar PrecisionCut 4

Directories

Main

This is the directory that LLumar Precision Cut 4 is loaded in. All the program files that are used by LLumar Precision Cut 4 must be in this directory.

Fonts

This is the directory where the Sign Wizard font files are loaded. Each font has two file types: FNT and FNS. The FNT file contains the font data, and the FNS file is the snapshot of the font. Both of these files must be in the Fonts directory, but if an FNS file is not there for any reason, the program will create a new one whenever the snapshot is required.

Layouts

This is the directory your layout files (LYT) are stored.

Graphics

This is the directory where your graphics (LGO) and image files (PCX, TIFF) are stored.

Plots

This is the directory where your plot files (SWP) are stored. These files are the native files for the Plot Manager, which are much simpler in structure than a layout (LYT) file and don’t contain elements that aren’t relevant to vinyl cutting.

Scratch

This is where temporary files are stored. Make sure this disk has adequate free space.

Backup

This is where backup versions of Layout (LYT) files will be stored. When the option to create backup files is enabled, whenever you save a layout any existing file of that same name will be moved to this folder before the new file is written.

Limited User Account Mode

This option will place all data files that can be changed by the program in a special folder outside the main program folder. This is necessary when using Windows XP in limited user account mode, where modification of files in the Program Files folder is not allowed.
Keyboard

Use this to change the default accelerator key assignments. You can create your own custom keyboard shortcuts with this feature!

Current / New Shortcut Key

Type any key in here. If it’s already used, the command it’s assigned to will be shown below in the Current Command field.

Current Command

This is the name of the current command being assigned a key, or the name of the command that is already assigned the key you typed in field above.

Commands and Keys

This list shows the command that are available and the current key assignments. To make a new assignment or change an existing one, select the command and type a new key.

Assign button

Press this to make a new assignment.

Remove button

Press this to remove a key assignment. Note that a command can have more than one key assigned to it, but the reverse is not possible.

Reset

Press this to reset all the key assignments to their factory default state.
Toolbars tab

You can change the content of the toolbars with this command.

Toolbar

Select the toolbar to change.

Available

Lists the commands that have a toolbar icon. Select the menu command to change.

Current

Shows the current contents of the selected toolbar.

Insert

Click this to add a new icon to the toolbar.

------------ >

Click this to add a small gap to the toolbar.

Append

Click this to add the icon to the end of the toolbar.

Remove

Click this to remove the icon from the toolbar.

Reset

Click to reset the toolbar to the factory default state.
**Toolbox Options Tab**

The **Toolbox** tab in Options lets you drag and drop new icons to the toolbox.

**Available Menu Commands For**

This list includes all the menu commands in the programs that have high color icons defined, showing the icon, menu command and group assigned to it. Above this list is a drop down menu where you can select from the available icon configurations, which are defined by the High Color Toolbox Editor.

**Group**
LLumar PrecisionCut 4

You can assign this icon to a group by typing a name here. If you want to use the group name of an existing nearby icon, simply click on that other icon, then Alt Click on the new icon and that name will be copied to the newly selected icon.

Search

You can search for icons by name with this search box.

Allow flyout to appear after a delay of ___ seconds

Use this checkbox to enable an automatic flyout mode, where you don't have to press the button to bring it up. With this unchecked, the seconds setting is used when pressing and holding the left button to bring up the flyout after the specified amount of seconds have passed.

Vertical Flyouts

Check this to have vertical flyouts with text. With this unchecked, the flyouts will be horizontal, without text.

Adding Icons to the Toolbox

To add icons to the toolbox, simply drag and drop them to the live toolbox in the workspace. A red dotted box will appear around the icon the new icon will be inserted before.
Switches

This dialog box consolidates all the yes/no program options into one place. These options are either checked or unchecked, according to the factory settings and whatever changes you have made.
In the descriptions below, the factory settings will be indicated.

Allow free movements on table

This switch will determine whether you can freely overlap objects on the table. The factory default is OFF. This means that objects will not overlap when you try to move one on top of the other. You can still overlap objects on the table by holding CTRL as you move them.

Always convert beziers to arcs before weld

The factory default for this switch is OFF, and there is no reason to turn it on. Weld is used in operations such as Shadow and Outline.

Auto Arrange Toolbars on Top and Bottom of Workspace

The factory default is OFF.

Auto Nest: Use Anti-Aliasing

Anti-Aliasing will typically give more accurate results on Auto Nest. The factory default is ON.

Automatically add new table widths after polling the cutter, if the polled width if not present

This switch provides a way to build up your table widths library with the actual widths from polling your cutter. The factory default is OFF, but if you use a finite number of material widths on one cutter, it may make sense to turn this on.

Check for new patterns on startup

Each time you start up LLumar Precision Cut 4, when this switch is ON, it will check the remote pattern database for updates and display a dialog box with the results. It may have patterns to add and it may have patterns that have been deleted. The factory default is ON. If you choose to turn off this switch, then you can manually check the remote pattern database with the function Update Pattern Database from the File Menu.

Check for self-intersecting loops before welding

This will increase the quality of the Weld function. The factory default for this switch is ON.

Cut: Always poll material width before sending to cutter
This switch will ensure that the Poll Material Width function is always run before you cut a pattern. The factory default is ON. This provides a final check to ensure that you don't send a pattern that is too big for the material you have loaded, which would waste material.

**Cut: Enable Plot Spooler Logging**

This switch provides diagnostic data on cutting and can be useful in troubleshooting plotting problems. The factory default is OFF but Technical Support may ask you to turn it on if you are reporting plotting problems.

**Cut: Use background thread when sending cut data**

When turned on, this switch would more easily allow you to continue using other applications on your computer while cutting. The factory default is OFF, which means that your computer will be mostly dedicated to sending the cut data. The actual performance of your system with this switch on and off depends on a variety of factors, so this is not a "cut and dried" switch. You can test with this switch on to see how your computer responds, and if you see any problems with the cutter pausing or not responding, then you should operate with this switch off.

**Make selection/group by intersecting with object (otherwise by enclosing)**

This switch provides an option for how you create a selection or group. The factory default is OFF, meaning that in order to make a selection or group of multiple objects, you must draw a box with the left mouse button completely around the objects that you want to include. If you turn this switch ON, then you can create a selection or group just by having the box intersect the objects you want to include.

**Easy Editor: Create resize nodes where necessary**

Use this to automatically create resize nodes in the Easy Editor. Use this with caution.

**Right Click Rotation**

This switch determines the methods of both Rotation and Zooming. The factory default is ON, which means that the right mouse button is used for Rotating an object. If you turn this switch OFF, then the right mouse button is used for Zooming (draw a zoom box with the right mouse button). Zooming can also be done with the mouse wheel, and Rotation can also be done with the lower middle control point.

**Select by clicking within bounding box**

This switch lets you determine how you select an object - either by clicking somewhere inside the bounding box of the object, which is the factory default (ON), or by clicking on the outline path of the object (OFF). Having this switch on can make it faster to select objects because you only have to click somewhere inside the bounding box, but it can also be somewhat less precise because there can be overlapping bounding boxes. Turning this switch off is more precise in selecting objects, but it can be slower since you have to take more care in where you click to make a selection.
Spell Check: Ignore ALL CAP words

The factory default for this switch is OFF. ALL CAP words can be acronyms or abbreviations, and you may wish to have the spell checker ignore them.

Spell Check: Ignore Capitalized words

The factory default for this switch is OFF. Capitalized words could be proper names, and you may wish to have the spell checker ignore them.

Spell Check: Ignore MixedCase words

The factory default for this switch is OFF. Same logic as above.

Text: Break into letters for nesting

The Auto Nest routine can either separate letters to make a tighter nesting, or keep the letters all together for ease of cutting/weeding/application. The factory default is ON.
Layout Tool

The **Layout Tool** is used for arranging, sizing, and distorting the elements of your layout. You select the Layout Tool by clicking once with the mouse on the icon shown. With it, you can select different parts to edit, transform, or distort, group parts together, or combine multiple parts into a new part. See the topics listed below additional information on these features.

**Moving**

To move a graphic or group, click on the edge of the path or within the bounding box of the item and then drag the mouse. Release the mouse to stop moving. You can also drag the center handle to move.

**Scaling**

Scaling is performed by dragging any one of the four corner handles and releasing the mouse when at the desired scale.

**Grouping**

To place graphics into a group, click where there are no graphics and drag a box around the objects to group them. Once grouped, they can be moved and scaled as a unit.

When the items you want to group are not within a simple rectangle, use Shift when clicking on each item to group them.

**Note:** To start the group box anywhere, use Alt when dragging the box, and the normal action of clicking within a graphic to move it will be avoided.
Vector Editing Tool

The Vector Edit property bar gives you information about the selected vector, and provides buttons for many functions.

Some of the commands in this tool are available on keys, such as Line, Arc, and Bezier.

Allow Editing

Check this to permit editing when in the On Screen Digitizing mode. Uncheck this to prevent accidental editing.

X

This is the horizontal position in the layout. Read only.

Y

This is the vertical position in the layout. Read only.

Radius

This is the radius of the arc. Read only.

Length

This is the length of the vector.

Angle of Arc

This is the angle of the arc, when an arc is selected. Read only.

Tangency

This is the tangency error between the selected vector and the following vector. Read only. Use Smooth Vectors to automatically decrease the tangency error for the entire graphic.

Add

Breaks the selected vector in two, at the point where you clicked to select the vector.

Line

Breaks the selected vector in two, at the point where you clicked to select the vector.
LLumar PrecisionCut 4

Converts the selected vector to a line.

**Arc**  
A key

Converts the selected vector to an arc.

**Bezier**  
B key

Convert the selected vector to a bezier curve.

**Sharp**

This turns the selected arc into a sharp corner, where the arc is replaced by two lines that are tangent with the adjacent vectors.

**Resize Editor**

This launches the [Easy Editor](#) (also known as Resize Editor)

**Break**  
O key

Breaks the loop open. Open loops cannot be filled with color, but they can display the stroke color.

**Set Start/End**  
E key

Set the start/end point of the current loop to the selected vector.

**Close**  

Closes the loop. Only closed loops can be filled with color.

**Toggle Corner**

This toggle the sharp corner flag when editing bezier curves, which determines whether two adjacent beziers will be forced to be tangent when editing one of them.

**Delete**  

Deletes the vector. Use Undo to bring it back.

**X Axis Mirror**  

Enables X-Axis mirroring.

**Y Axis Mirror**  

Enables Y-Axis mirroring.
**Horizontal Guide**

Adds a horizontal guideline at the selected vector.

**Vertical Guide**

Adds a vertical guide at the selected vector.
Loop Editing Tool

The Loop Edit tool is designed for editing entire loops, not graphics or individual vectors.

Width

This is the width of the loop.

Height

This is the height of the loop.

Length

This is the length of the loop.

Reverse Loop

This will reverse the direction of the loop.

Open Loop

This will open up the loop. Open loops cannot be filled with color.

Close Loop

This will close the loop. Only closed loops can be filled with color.

To Circle

This will turn the loop into a circle.

Delete Loop

This will delete the loop. You can retrieve it again with Undo.

Show Loop Numbers

This will show the loop numbers.
On-Screen Digitizing Tool

**On Screen Digitizing** is the tool for creating a new vector graphic from scratch. You use the keyboard to switch between various modes. You can edit previously nodes the same way you would in the Vector Edit tool, because the On Screen Digitizing tool is a special mode of the Vector Editing Tool.

**Start New Path - N Key**
- Press N to start a new path.

**Line – W key**
- In this mode, each click creates a simple line.

**Arc – A key**
- In this mode, you click and drag to create an arc. The click point is the midpoint of the arc, and then you drag to the end point.

**Tangent Arc – T key**
- In this mode, only two points define the arc, because it has to be tangent with the last vector. Click and drag to the end of the arc.

**Bezier – S key**
- In this powerful mode, each click and drag defines a tangent bezier curve. After you click, you've defined the end point of the bezier, but the 3rd control point is automatically defined in such a way that a gentle curve is created, much like the Tangent Arc mode. If you then drag further, the cursor becomes a way to change the 3rd control point, but not directly. Experiment with it a few times and it becomes clear how it works.
Dimensions

The Dimension tool lets you enter dimensions quickly and accurately. To activate the Dimension feature, select Dimensions in the Tools menu or from the toolbox. As you move the cursor around the screen, you will see guidelines appear momentarily when the cursor is aligned with any straight line in the design. To start a dimension at any horizontal, vertical or diagonal guideline, click and drag with the left mouse button from the first line to the second line which must be parallel to the first line and release the mouse button.

After the dimensions have been entered, the size of the numbers and the arrowheads can be increased or decreased by clicking with the left mouse button on the up or down arrows to the right of the box showing the current height. Each mouse click will increase or decrease the size by 30. You can also change the arrowhead type by clicking on the appropriate button to the right of the number size box. All the numbers are aligned with the dimension line.

The default sizes of the numbers and the arrowheads can be changed by clicking on the Tools menu, Options and then the Tools tab. In the Dimensions box you can then modify the Arrow Size and the Text Label Size which are a percentage of the layout height. You can also modify the Number Type (feet, inches, decimals, fractions, etc.), and the Resolution used for fractions (1/8, 1/16, 1/32, etc.)

This is the Dimension property bar:

- **Dimension Length**

  This number field is the length of the dimension, which can be read only or one you can edit, when the Auto Calced Dimensions option (below) is checked, which is the default. When Auto Calced Dimensions is not checked, you can enter the number in here and the size of the dimension object does not effect this value at all.

- **Auto Calced Dimensions**

  This option button enables or disables the auto calculation mode. This is normally enabled. When disabled (button is in the "up" position, not pressed), can may enter any value into the length field (above) and it won't change, even if you change the size of the dimension object.

- **Create Dimension Mode**

  In this mode, when you click away from any dimension, you will be creating a new dimension object. With this disabled, you won't accidently create new dimensions when clicking where there's no existing dimension.

- **Do Diagonal Snaps**

  Turn this on to allow diagonal lines to be used as snap points. This is normally not needed.

- **Link Dimensions**

  226
Turn this on to link the dimensions to the graphic’s edge guidelines they snap to, so that if and when the graphics move, the guidelines move along with them.

**Dimension Arrow Length**

This field lets you specify how long the arrow is in the dimension objects. This is relative to the height of the layout.

**Dimension Text Height**

This field lets you specify how height text is in dimension labels. This is relative to the height of the layout.

**Line Width**

This field specifies the width of the lines used to draw the dimensions.

**Arrow Type 1**

This selects the first arrow type.

**Arrow Type 2**

This selects the second arrow type.

**Arrow Type 3**

This selects the third arrow type.

**White Dimensions**

This button enables white dimension lines, which is useful when the layout has a dark background color.

**Delete**

This button deletes the selected dimension object. You can use the Del as well. Here is a screen shot showing the program using the Dimension tool.
Measure

<table>
<thead>
<tr>
<th>New Length:</th>
<th>Total Length:</th>
<th>Horizontal:</th>
<th>Vertical:</th>
<th>Auto Square</th>
<th>Snap To Path</th>
</tr>
</thead>
</table>

The Measuring Tool allows you to easily measure the distance between two points in your layout. This tool behaves like the three main tools (Layout, Vector Editor, and Loop Editor) in that it will stay active until you select another tool.

**New Length**

Enter a number in here if you want scale the selected graphic to a scale factor formed from the New Length and Total Length.

**Total Length**

This is the total length of the ruler.

**Horizontal**

This is the horizontal span of the ruler.

**Vertical**

This is the vertical span of the ruler.

**Auto Square**

This option causes the ruler to snap to horizontal or vertical when the angle is close to horizontal or vertical.

**Snap to Path**

With this checked, the ruler will snap to the end points of any lines in all the vector graphics in the layout. You can also enable snapping with the Shift key, even when this option is disabled.

**Defining the Ruler**

When you first select the tool, you need to define the initial "ruler", and then you can move the two endpoints of the "ruler" around until you see the measurement you need. First, click the left button where you want one end of the ruler to be. Then, drag the mouse over to where you want the other end of the ruler to be, and release the left mouse button. You will then see the complete ruler. The horizontal, vertical and diagonal measures will appear at the top status bar.

**Adjusting the Ruler**

At this point you can readjust either end point just clicking close to the desired end point, and dragging it to a new position. You can also bring in guidelines to help you position the ruler.
more exactly, because when you move the end points, they will automatically snap to any guideline or gridlines that are close enough.

To finish with the Measuring Tool, simply click on another "modal" tool such as the Layout Tool, or press Esc.
**Radius Corners**

This command lets you automatically or manually convert sharp corners into radiused or fillet corners, specifically designed for creating push through letters.

**Outer Radius**

This is the radius to use with outer corners, which are “right turns”. For example, a square that is ordered clockwise will have only outer corners. A “W” will have three inner corners or left turns.

**Inner Radius**

This is the opposite turn from Outer Radius, above. These are left turns. Note that these are opposite with inner loops, so that outer radiuses become inner radiuses and vice versa.

This tool has a manual mode, in which you can simply left click on individual corners to convert them to radii.

Only nodes with a tangency error of more than 10 degrees will be converted to radii.
Recreate with Bezier Curves - Tight

This command will recreate the selected vector graphic using bezier curves, on the tight setting, which creates more nodes and tracks the original path the best, but is not as smooth.
Recreate with Bezier Curves - Medium

This command will recreate the selected vector graphic using bezier curves, using a setting that balances tight tracking with smoothness.
Recreate with Bezier Curves - Loose

This command will recreate the selected vector graphic using bezier curves, using a setting that is very smooth won't track the original shape as well as the other two settings.
Remove Duplicate Loops

Use this command to remove duplicate loops within a graphic. You can tell when you have duplicate loops, which will cause problem when cutting, if you move a graphic and see the same shape remain behind.
Convert

Convert Beziers to Arcs

This command will convert the selected object's vectors into arcs and lines, removing any bezier curves that may be used in the object.
ConvertArcsToBeziers

This command will convert the selected object's arcs into bezier curves, which are often easier to edit and distort than arcs. Most of the commands in the Distortion menu to this conversion automatically before actually distorting the vectors, since bezier curves can be distorted much easier than arcs.
**Convert to All Lines**

This command converts all arcs and bezier curves in the selected graphic into multiple lines, according to the current curve resolution settings used to display such arcs and bezier curves, as specified in the global Options dialog.
Convert Lines to Arcs

This command will convert an object that is only lines into one that contains arcs and lines. It tries to determine where a series of lines actually form an arc and substitute an arc in their place.
**Convert Blend Flat Blend to Simple Fills**

Use this command to convert all flat blend objects in the layout to simple fills.
Convert All Clipping Paths to Normal Paths

Use this command when you have imported an EPS/PDF file that use clipping paths extensively, but become difficult to manage. This creates unfilled graphics.
Convert All Clipping Paths to Normal Filled Paths

Use this command when you have imported an EPS/PDF file that use clipping paths extensively (instead of simple fills), but become difficult to manage when imported. This creates filled graphics, where it is assumed that there is a simple filled rectangle being clipped and the actual graphic is the clipping path. This may not work in all cases.
Remove All Clipping Paths

Use this command to remove all the clipping paths in the layout. This is handy when importing certain PDF/AI/EPS files that contain many unnecessary clipping paths and can cause problems when imported.
LLumar PrecisionCut 4

Use this command to find where a graphic intersects itself, which may be hard to tell sometimes. The program will highlight and zoom into the areas that have self-intersecting loops, which you can then remove with the Vector Edit tool.
Using Standard Line Spacing with TrueType Fonts

This command will use the standard line spacing with TrueType fonts. With this off, LLumar Precision Cut 4 will use a line spacing value that can work better in some cases.
Force Loop Direction

This option forces the loop direction to be recalculated when using Weld.
Fix menu

The commands in this menu are used in tech support cases.
Display Path Length

This option adds a path length calculation to the status bar under the property bar area. It can cause delays on large data sets and that's why it's an option.
Help

Contents

This command loads this online help file.
**Context-Sensitive Help**

Press F1 to display Online Help for the part of the program you are currently using.
System Information

This command will launch the Windows System Information tool and help with sending technical information about your computer to technical support.
Remote Tech Support

This menu provides access to a remote tech support system, in which the tech support staff can view and operate your computer.
Authorize

This command displays the Authorization dialog box, shown below.

![Authorization dialog box](image)
LLumar PrecisionCut 4

**About**

This displays the version number and copyright for this software.